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Введение в COMSOL Multiphysics 
 

COMSOL Multiphysics - это мощная интерактивная среда для 
моделирования и расчетов большинства научных и инженерных задач 
основанных на дифференциальных уравнениях в частных производных 
(PDE) методом конечных элементов.  С этим программным пакетом вы 
можете расширять стандартные модели использующие одно 
дифференциальное уравнение (прикладной режим) в мультифизические 
модели для расчета связанных между собой физических явлений. Расчет не 
требует глубокого знания математической физики и метода конечных 
элементов. Это возможно благодаря встроенным физическим режимам, где 
коэффициенты PDE задаются в виде понятных физических свойств и 
условий, таких как: теплопроводность, теплоемкость, коэффициент 
теплоотдачи, объемная мощность и т.п. в зависимости от выбранного 
физического раздела. Преобразование этих параметров в коэффициенты 
математических уравнений происходит автоматически. Взаимодействие с 
программой возможно стандартным способом – через графический 
интерфейс пользователя (GUI), либо программированием с помощью 
скриптов на языке COMSOL Script или языке MATLAB. Данное пособие 
рассматривает основы работы с программой только через графический 
интерфейс. 

Программа основана на системе дифференциальных уравнений в 
частных производных. Существует три математических способа задания 
таких систем:  

• Коэффициентная форма, предназначенная для линейных и близких 
к линейным моделей 

• Генеральная форма, для нелинейных моделей 
• Слабая форма (Weak form), для моделей с PDE на границах, ребрах 

или для моделей использующих условия со смешанными и 
производными по времени. 

Используя эти способы, можно изменять типы анализа, включая: 
• Стационарный и переходный анализ 
• Линейный и нелинейный анализ 
• Модальный анализ и анализ собственных частот 

Для решения PDE, COMSOL Multiphysics использует метод 
конечных элементов (FEM). Программное обеспечение запускает 
конечноэлементный анализ вместе с сеткой учитывающей геометрическую 
конфигурацию тел и контролем ошибок с использованием разнообразных 
численных решателей. Так как многие физические законы выражаются в 
форме PDE, становится возможным моделировать широкий спектр 
научных и инженерных явлений из многих областей физики таких как: 
акустика, химические реакции, диффузия, электромагнетизм, 
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гидродинамика, фильтрование, тепломассоперенос, оптика, квантовая 
механика, полупроводниковые устройства, сопромат и многих других. 

Кроме вышеперечисленного, программа позволяет с помощью 
переменных связи (coupling variables) соединять модели в разных 
геометриях и связывать между собой модели разных размерностей. 

Для создания и расчета задачи рекомендуется следующая 
последовательность действий. 

1. Выбираем размерность модели, определяем физический раздел в 
Model Navigator [Навигаторе моделей] (каждому разделу 
соответствует определенное дифференциальное уравнение) и 
определяем стационарный или нестационарный анализ 
температурного поля. 

2. Определяем рабочую область и задаем геометрию 
3. Задаём исходные данные, зависимости переменных от координат и 

времени 
4. Указываем теплофизические свойства и начальные условия 
5. Указываем граничные условия 
6. Задаём параметры и строим сетку 
7. Определяем параметры решающего устройства и запускаем расчет. 
8. Настраиваем режим отображения 
9. Получаем результаты 
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1. Работа с COMSOL Multiphysics 
 

1.1. Навигатор моделей и главное меню 
 
 

 Выбирая размерность модели, следует помнить, что просто задание 
сетки в трехмерной модели может занимать десятки минут даже на 
мощном компьютере. Для большинства трехмерных задач имеет смысл 
сначала задать и рассчитать двумерную модель, а уже потом при 
необходимости повторить расчет для трехмерной модели. Тем более, что 
если вы не импортируете геометрию из внешней CAD системы, а задаете 
непосредственно в FEMLAB, то гораздо удобнее получить трехмерную 
модель, преобразованием соответствующей двумерной. Размерность 
модели выбирается в окне Model Navigator [Навигатор моделей] (Рис. 
1.1) на первой вкладке New в Space Dimension [Размерность 
пространства], кроме 1D, 2D и 3D там есть Axial Symmetry (1D) и (2D) 
для осесимметричных моделей. 
 

 Теперь выбираем физический раздел, в рамках данного пособия 
рассмотрены три основных раздела Heat Transfer [Теплоперенос], 
Diffusion [Диффузия] и, в составе мультифизической модели, Fluid 
Dynamics [Гидродинамика].  Раздел Fluid Dynamics использует 
уравнение Навье-Стокса для несжимаемой жидкости. Раздел Heat Transfer 
включает в себя, кроме подраздела Conduction [Кондукция], подраздел 
Convection and Conduction [Конвекция и кондукция], который 
отличается тем, что кроме теплофизических свойств, можно задать поле 
скоростей теплоносителя. Раздел Diffusion тоже состоит из двух 
подразделов: Diffusion [Диффузия] и Convection and Diffusion 
[Конвекция и диффузия]. Один из модулей расширения General Heat 
Transfer [Общий теплоперенос] включает в себя объединенные с 
излучением, конвекцию и кондукцию, а так же разделы, Thin Conductive 
Layer – тонкий теплопроводный слой, Bioheat equation – режим расчета 
тепломассопереноса в живых тканях,  Non-Isotermal Flow – 
неизотермический поток.  
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Рисунок 1.1. Окно Навигатор моделей. 
 

Чтобы создать мультифизические модели, например, охлаждение 
конвективным потоком в канале: надо нажать кнопку Multiphisics, затем 
нажимается кнопка Add geometry [Добавить геометрию], в открывшемся 
окне выбирается размерность и названия осей. После выбора геометрии, 
нажимается кнопка Add… [Добавить] и сначала выбирается один 
физический раздел (Heat Transfer→Convection and Conduction), а потом 
в модель добавляется второй раздел (Fluid Dynamics→Incompressible 
Navier-Stokes). Между собой они взаимодействуют как раз через поле 
скоростей. 

 Для каждого из подразделов можно выбрать Steady-state analysis 
[Стационарный анализ] или Transient analysis [Переходный анализ], 
впрочем, вид анализа можно потом изменить. 

 Так же на вкладке New в Model Navigator можно выбрать вид 
конечных элементов, по умолчанию стоит Lagrange-Quadratic 
[Лагранжевы-квадратичные], предлагаются Лагранжевы элементы 
вплоть до пятой степени, в некоторых разделах доступны Эрмитовы, 
элементы Эйлера и множество других прикладных элементов.  
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Кроме New, в Model Navigator, есть еще три вкладки. Model Library 
[Библиотека моделей], в ней расположены примеры моделей для всех 
физических разделов, некоторые из этих моделей присутствуют в данном 
пособии. User Models [Пользовательские модели], представляет собой 
отображение папки, в которой хранятся модели созданные. Settings 
[Настройки] позволяют установить язык (при установленном 
русификаторе, даже русский). И изменить фон рабочей области с белого на 
черный. В версии COMSOL 3.2 там же устанавливается система единиц, 
можно выбрать из десяти вариантов включая СИ. Кроме того в этой версии 
появилась вкладка Open которая так же как и User Models позволяет 
работать с файлами. 

После нажатия клавиши OK в Model Navigator открывается окно 
основной программы с рабочей областью, инструментальными панелями и 
главным меню. Кнопки на инструментальных панелях повторяют пункты 
главного меню, поэтому мы рассмотрим пункты меню по порядку.  
 

Главное меню 
 

File – содержит команды создания, открытия и сохранения файлов, 
печати, а также импорта геометрии из внешних CAD систем и экспорта 
полученных данных в текстовый файл. 

Edit – содержит команды отмены и повторения операций, работы с 
буфером обмена и команды выделения. 

Options – содержит команды задания рабочей области Axes/Grid 
settings, констант Constants, выражений Expression, функций Function, 
связанных переменных Coupling Variables и различные настройки 
отображения геометрических элементов и масштаба. 

 Draw – содержит команды построения и преобразования 
геометрических объектов, а так же команды превращения двумерных 
объектов в трехмерные. 

 Physics – содержит команды задания физических свойств 
подобластей Subdomain, граничных условий Boundary, в том числе 
периодических ГУ (Граничных Условий) Periodic Condition и изменения 
системы дифференциальных уравнений Equation system. 

 Mesh – содержит команды управления конечноэлементной сеткой. 
 Solve – содержит очень важные команды управления решающим 

устройством, можно выбрать зависимость от времени, линейность или 
нелинейность, а так же указать множество других параметров решателя. 

 Postprocessing – содержит команды для отображения результатов 
вычислений, во всех возможных видах: от векторов и поверхностей 
уровня, до графиков и интегралов по границе. 
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 Multiphisics – открывает Model Navigator, и позволяет 
переключаться между физическими режимами в мультифизических 
моделях. 

 Help – содержит обширную справочную систему. 
 

1.2. Рабочая область и задание геометрии 
 
Итак, мы открыли окно основной программы (Рис. 1.2): если мы 

выбрали размерность пространства 1D, то мы видим рабочую область с 
координатной осью и кнопками для рисования геометрии. В одномерном 
режиме это кнопки point [точка], line [линия], mirror (отображает объект 
зеркально), move (перемещает объект) и scale (изменяет размер объекта). 
Также в верхней части экрана есть стандартные кнопки для выполнения 
операций с файлом и буфером обмена; и кнопки повторяющие основные 
команды из разделов Mesh, Solve и Postprocessing главного меню. 

 
 

Рис 1.2. Рабочая область. 
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В режиме 2D добавляются кнопки создания кривых Безье, 
прямоугольников и овалов, кнопка Array [массив] создающая из одного 
объекта, матрицу объектов любого размера. Кнопка Rotate [вращение] 
позволяет повернуть созданный объект на любой угол. В трехмерном 
режиме с помощью кнопок можно создавать параллелепипеды, 
эллипсоиды, конусы, цилиндры и шары, а также управлять расположением 
координатных осей и освещением фигуры.   

В первую очередь рекомендуется задать границы отображаемой 
рабочей области Options>Axes/Grid settings [Опции>Установки 
оси/решетки]. Предположим, что мы работаем в двумерном режиме и 
хотим задать модель объекта с размерами метр на метр. В открывшемся 
окне выбираем вкладку Axis [Оси], галочка Axis equal означает, что оси 
будут равны, то есть один метр по оси Х будет визуально такого же 
размера как по оси Y. Для протяженных объектов эту галочку можно 
снять, и тогда на экране оси могут быть не равны. Это удобно, когда в 
каком-нибудь из измерений объект непропорционально большой.  

В разделе x-y limits нужно задать пределы отображения осей, в нашем 
случае это 0 и 1.1 для минимума и максимума соответствующих осей. На 
вкладке Grid [Решетка] можно снять галочку Auto и самим установить 
интервал решетки. Вообще, при построении модели можно задавать 
просто координаты соответствующих фигур (например, координаты 
центра окружности и ее радиус), но часто удобнее задать фигуру просто 
отметив эти координаты с помощью мыши, и тогда очень важно чтобы 
узлы решетки совпадали с ключевыми точками фигуры.  

Поэтому если толщина 
минимального эле-
мента составляет, 
скажем, один 
миллиметр, то целе-
сообразно  задать 
именно такой интервал 
сетки. Галочка Visible 
позволяет выключить  
режим отображения 
решетки. Внизу 
рабочей области можно 

выключить и привязку мыши к решетке SNAP, но тогда в случае ввода 
объекта с помощью мыши ключевые точки можно будет задать лишь 
примерно. В области x-y grid можно задать в полях x и y spacing интервал 
решетки по соответствующим осям. Поля Extra x и Extra y позволяют 
добавить любое количество дополнительных линий решетки.  

⇒ Внимание: Не стоит путать понятия Grid – решетка и Mesh – сетка 
конечных элементов. Grid служит только для удобства задания 
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геометрии модели и никак не влияет на расчеты. От сетки же 
конечных элементов Mesh напрямую зависит точность расчетов.  

После задания решетки 
можно приступить к 
определению гео-
метрии. Если она у нас 
заранее не создана во 
внешней CAD 
программе или не 
задана в MATLAB (в 
этих случаях она 
просто импортируется 
через File>Import), то 
придется ее задавать 

внутренними средствами. Предположим, надо нарисовать прямоугольник. 
Можно воспользоваться соответствующими кнопками Rectangle/Square 
[прямоугольник/квадрат] и Rectangle/Square (Centered) 
[прямоугольник/квадрат (центрированный)], первым щелчком отмечается 
расположение угла или центра, а потом прямоугольник растягивается до 
нужного размера и закрепляется вторым щелчком. При нажатой клавише 
Ctrl создается квадрат. Если нажать на клавишу Shift и щелкнуть на 
кнопке, то откроется окно со всеми параметрами фигуры. Это же окно 
можно открыть через главное меню: Draw>Specify objects.  

Size задает размер объекта с помощью полей Width [ширина] и Height 
[высота]. Rotation angle задаёт угол поворота прямоугольника в градусах.  

Область Position определяет место расположения объекта. 
Раскрывающийся список Base позволяет определить к чему относятся 
координаты x и y. Corner означает, что мы задаем расположение угла 
прямоугольника (если мы рисуем эллипс, то надо задать координаты 
описанного прямоугольника). Center – мы задаем координаты центра 
объекта.  

Раскрывающийся список 
Style, предлагает варианты 
Solid – будет создана целая 
фигура – и Curve – будет 
создана кривая-контур 
фигуры. Кривая необходима 
для создания сложной 
фигуры: сначала задаются 
кривые, границы объекта, а 
потом командой Coerce to 
solid выделенные кривые 
делаются цельной фигурой. В 
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режиме 3D вместо Curve – кривая есть понятие Face – оболочка. В поле 
Name можно вписать имя объекта.  

Несмотря на то, что в окнах Specify objects можно задать точные 
координаты и размеры объектов, часто легче задавать их с помощью 
мыши, а кривые Безье можно задать только с помощью мыши. Вот почему 
важно заранее определить период решетки.  
      При задании сложных фигур приходится задавать десятки 
элементарных объектов (овалы, прямоугольники, кривые Безье, линии, 
точки) потом их надо объединить или разделить. Обычно это делается по 
физическим признакам, с помощью кнопок Union [объединить], 
Difference [разность], и Intersection [пересечение] или команды 
Draw>Create Composite Object… Эта команда открывает окно, где можно 
указать из каких элементов создается фигура.  
       После создания фигуры с помощью кнопки Fillet/Chamfer или 
одноименного пункта меню Draw можно задать фаски или скругления 
углов. Так же можно размножить фигуру с помощью кнопки Array, 
отразить с помощью Mirror,  и изменить размер с помощью Scale. Кнопки 
Rotate и Move поворачивают и сдвигают выделенную фигуру 
соответственно. Все эти кнопки повторяются в виде пунктов меню 
Draw>Modify.  

Для создания 
трехмерных моделей 
удобно элементарные 
фигуры задавать в 
режиме 3D, а более 
сложные задать сначала 
в режиме 2D, а потом 
перенести в трехмер-
ную область. Например, 
мы создали прямо-
угольник 1x0.5 метра.  

Если его выделить и 
нажать кнопку Draw> 
Extrude то откроется 

окно Extrude [Экструзия] где можно задать объект подвергающийся 
операции, название рабочей области (для одной модели можно задать 
несколько рабочих областей, обычно это несколько 2D геометрий и одна 
составная 3D). Поле Distance определяет на сколько будет растянуто 
сечение. Если у нас был нарисован круг, то после Экструзии будет 
цилиндр, если сечение рельсы, то будет модель рельсы. Scale x и y задают 
во сколько раз будет изменяться сечение по длине объекта. Если задать в 
эти поля две двойки, то после экструзии (если сечение было круглым) 
появится усеченный конус. Displacement определяет сдвиг верхней 
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плоскости фигуры относительно основания. Twist закручивает фигуру 
вокруг своей оси. 

Draw>Embed скопирует наш двумерный прямоугольник в трехмерную 
рабочую область. По умолчанию в плоскость z=0. Плоскость задается 
через Draw>work plane settings… 

Draw>Revolve, создаст фигуру вращения. То есть из прямоугольника 
можно создать кольцо с прямоугольным сечением. В открывшемся окне 
можно задать градусы вращения по двум осям и координаты точек вокруг 
которых будет создаваться фигура вращения.  

Для наглядности, с помощью команды Scene Light можно установить 
«освещение объекта», кнопка Zoom extents поместит фигуру на весь 
экран. 

Если в процессе дальнейшей работы с моделью понадобится изменить 
какой-либо элемент геометрии, вернуться в режим ввода геометрии можно 
с помощью команды Draw>Draw Mode или кнопки Draw Mode . 

 
1.3. Функции, константы и выражения 

 
Теплофизические параметры могут зависеть от температуры и 

координат, внешние воздействия могут описываться различными 
функциями, зависящими от времени и множества других параметров. В 
расчетных уравнениях могут присутствовать различные константы, при 
чем значения этих констант могут различаться для разных частей системы 
(например: коэффициент теплоотдачи или коэффициент черноты 
поверхности).  

В пакете Comsol (Femlab) существует мощный инструментарий для 
работы с константами и функциями. Большинство этих команд находится 
в меню Options. Рассмотрим некоторые из них.  

 Constants [Константы] рекомендуется все применяемые в системе 
константы вынести в эту таблицу, а во всех формулах задавать 
только буквенное обозначение. Например, задать температуру 
окружающего воздуха Т_air=30, а во всех граничных условиях 
вместо цифры задавать Т_air. Тогда в случае необходимости можно 
будет поменять одну цифру, а не менять по всем граничным 
условиям температуру окружающего воздуха. Так же список всех 
часто употребляемых констант можно сохранить в отдельный файл и 
переносить из модели в модель. В последних версиях программы 
появилась возможность – к каждой константе написать Description 
[Примечание], при работе нескольких человек с одной моделью не 
стоит игнорировать эту графу. 

 Expression [Выражения] содержит Scalar expression [Скалярные 
выражения], Subdomain, Boundary, Edge(только в трехмерном 
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режиме) и Point expression. Можно задать зависимость 
теплофизического параметра от времени t; координат x, y, z; от 
безразмерной координаты s (изменяется от 0 до 1 по длине каждой 
границы) или от любых других вычисляемых параметров. Например 
Q_ist=100*exp(t). У различных элементов системы очень часто одни 
и те же параметры определяются по разным законам. Есть 
возможность задать одно имя у переменной, например alfa. И открыв 
Boundary expression [Граничные выражения] задать для разных 
границ, различные формулы вычисления alfa. Тогда для всех границ 
можно будет задать коэффициент теплообмена alfa, а программа 
сама подставит для каждой границы соответствующую формулу. 

 Coupling Variables [Переменные связи] с помощью этих пунктов 
меню можно задавать очень сложные зависимости между частями 
системы. Например связать граничные условия с интегралом по 
объему. 

 Functions [Функция] можно задать свою функцию, причем не 
только используя математические выражения. Если выбрать 
Interpolation function, то можно задать массив параметров и массив 
значений функций, и по ним построить интерполяционную 
функцию. Можно задать метод интерполяции, есть возможность 
импортировать данные из внешнего файла. 

 Coordinate systems [Системы координат] можно создать 
произвольную систему координат, с любым расположением осей 
относительно друг друга.  

 Material/Coefficients Library [Библиотека материалов] в ней есть 
возможность задать любые физические свойства веществ, и даже их 
зависимость от параметров (температуры и давления). 

 Visualization/Selection settings [Установки визуализации] 
позволяют управлять отображением объектов, освещением и 
выделением. 

 Suppress [Скрытие] В сложных объектах для наглядности иногда 
нужно сделать невидимым какой либо элемент системы. Например, 
если рассматривается процесс конвективного охлаждения, 
нагляднее, если воздух будет не виден, а будет видна только 
охлаждаемая поверхность с распределением температуры.  

 
1.4. Задание теплофизических свойств материалов 

и начальных условий 
 

Когда геометрия задана и все константы определены, можно 
приступить к заданию теплофизических свойств. Для начала открываем 
меню Physics>Subdomain Settings или F8: откроется окно ввода 
коэффициентов соответствующих дифференциальных уравнений (Рис. 
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1.3). Для каждого из физических режимов это окно имеет свой вид, и все 
поля будут рассмотрены в соответствующих главах. Здесь же мы 
рассмотрим только общие для всех режимов поля. На рисунке показано это 
окно для режима Heat Transfer by Conduction в трехмерном режиме. 
Наверху в поле Equation, указано текущее уравнение. В поле Subdomain 
selection, необходимо выбрать область, для которой определяются 
физические свойства. Если областей много, то нужно выделить все 
созданные из одного материала. Чтобы выделить все области надо нажать 
Ctrl+A. 

 
Рисунок 1.3. Окно Subdomain Settings. 

 
Во вкладке Physics надо задать свойства материала, в данном случае 

теплофизические, для распространенных материалов можно 
воспользоваться встроенной библиотекой. В нестационарном режиме 
присутствует поле Time-scaling coefficient [Временной коэффициент]. 
Значение 1 соответствует заданию времени в секундах. Если мы 
рассматриваем процессы идущие значительно больше или меньше чем 
одна секунда, то удобнее задать другой коэффициент и указывать внешние 
воздействия в соответствующих единицах. Для того что бы работать с 
временем в минутах в это поле надо записать 1/60, если в часах то 1/3600 и 
т.д.  

Кроме этого можно задать дополнительные параметры объекта. В 
режиме теплопереноса это объемная мощность. В режиме уравнения 
Навье-Стокса и Конвекции это скорость потока по всем осям.  В каждом из 
полей можно вводить математические выражения, синтаксис такой же как 
у MATLAB, но удобнее вводить в поля не формулы, а названия 
переменных, и определять их через Options>Expression.   
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В режимах связанных с конвекцией, диффузией или потоком жидкости, 
во вкладке появляется кнопка Artificial Diffusion… [Искусственная 
диффузия] она позволяет стабилизировать решение. Метод конечных 
элементов подразумевает дискретизацию пространства. При 
моделировании явлений переноса в сложных объектах это может привести 
к нестабильности решения. Нестабильность можно обнаружить увидев 
большие колебания значений в областях с большими градиентами. Из-за 
больших колебаний решение может не сходиться. Нажимая Solve>Restart 
[Решать>Заново] новое решение будет отличатся от предыдущего. 
Методы стабилизации решения основаны на добавлении малых слагаемых 
в дифференциальные уравнения.  

Вкладка Init предназначена для задания начальных условий, в данном 
случае это температура. Вкладка Element позволяет выбрать вид конечных 
элементов и их коэффициенты.  

В последней версии программы COMSOL 3.2 появились вкладки 
Groups и Color. Вкладка Group позволяет распределить различные 
элементы по группам и менять свойства сразу у всей группы. По 
умолчанию, они раскрашиваются в разные цвета, изменить этот режим 
можно с помощью вкладки Color.  

 
1.5. Задание граничных условий и изменение 

дифференциальных уравнений 
 

 
Рисунок 1.4. Окно Boundary Settings. 

 
Задание Физических свойств в областях, Граничных Условий и условий 

на ребрах или точках происходит в соответствующих режимах, которые 
автоматически включаются при открытии окон ввода свойств этих 
элементов. Вручную режимы включаются кнопками Point Mode, Edge 
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Mode, Boundary Mode и Subdomain Mode  или командами из 
раздела меню Physics>Selection Mode>… 

Граничные условия задаются через Physics> Boundary Settings или F7. 
В этом окне (Рис. 1.4) надо выбрать необходимые границы в поле 
Boundary selection. Для того, чтобы задать температурный перепад на 
границе двух тел надо сначала включить галочку Interior boundaries 
иначе внутренние границы будут недоступны. Во вкладке Coefficients 
надо выбрать вид граничных условий и указать в соответствующих полях 
коэффициенты ГУ. На рисунке показан пример задания граничного 
условия третьего рода. В поле Equation выводится соответствующее 
уравнение. 

Как и в окне Subdomain Settings в окне Boundary Settings последней 
версии программы - СOMSOL 3.2 появились вкладки Groups и Color 
присваивающие границам с различными ГУ разные цвета. В режиме 
расчета теплопереноса излучением в модуле General Heat Transfer, кроме 
группировки по свойствам теплообмена, для экономии вычислительных 
ресурсов, появляется группировка по взаимодействующим границам. То 
есть принято, что обмениваются излучением («видят друг друга») только 
границы принадлежащие к одной группе. Эта группа задаётся отдельным 
полем Member of Group(s) во вкладке Boundary Condition.  

В некоторых моделях (в основном связанных с электричеством) кроме 
свойств на границе необходимо задавать свойства ребер и точек. В режиме 
Fluid Flow>Incompressible Navier-Stokes так же необходимо задавать 
давление в точке. 

Часто при моделировании сложных систем, например 
радиоэлектронных аппаратов кассетного типа, выделяют элементарный 
объем и проводят расчет для этого элементарного объема. Для корректного 
расчета необходимо задать особый вид граничных условий – 
периодические граничные условия. В программе они задаются с помощью 
команды меню Physics>Periodic Condition. Кроме условий на границе 
Boundary требуется задать периодические свойства для точек Point и в 
некоторых режимах для ребер Edge. Настройки этих окон позволяют 
задать зависимость противоположных границ элементарного объема. 

Для некоторых классов мультифизических задач, где надо связать два 
объекта с разным типом сетки (например, прямоугольную сетку в одной 
части системы с треугольной в другой) и граничными условиями 
неразрывности можно применять условия идентичности Physics>Identity 
Conditions. 

В COMSOL 3.2 есть много возможностей гибкой настройки системы 
под каждую конкретную задачу. Можно изменять систему 
Дифференциальных Уравнений в Частных Производных (PDE). Для этого 
служит группа команд Physics>Equation system. Эти команды позволяют в 
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широких пределах изменять исходные PDE, способы задания начальных и 
граничных условий, а также параметры конечных элементов.  

Рассмотрим на примере уравнения теплопереноса.[1] В общем виде 
нестационарный процесс переноса выражается в коэффициентной форме 
уравнением 1.1:  
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                            1.1 

 
В прикладных режимах это уравнение представляется в упрощенном виде 
без лишних членов. Например, нестационарное уравнение 
теплопроводности (режим Heat Transfer>Conduction) выглядит так: 
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То есть ca, α, β, γ и a равны нулю. C учетом конвекции в режиме Heat 
Transfer>Convection and Conduction добавляется коэффициент α=ρ*Cp*u 
(где u поле скоростей) и уравнение выглядит так:  
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Для быстропротекающих тепловых процессов, где закон Фурье уже не 

работает, добавляется коэффициент ca со второй производной по времени 
от температуры [3], стандартный прикладной режим теплопереноса его 
учитывать не будет.  

Чтобы самостоятельно добавить значения необходимых коэффициентов 
открываем окно Physics>Equation system>Subdomain settings или 
Ctrl+F8, здесь можно для каждой подобласти (Subdomain) задать в 
прямом виде значение любого коэффициента PDE или же изменить 
формулу вычисления коэффициентов. У каждой области для которой мы 
примем изменения, появится значок замка. Он будет виден и из окна 
Physics>Subdomain settings. Приоритет всех значений у окна 
Physics>Equation system>Subdomain settings, поэтому надо проверять 
какие коэффициенты уже здесь указаны, а лишь потом задавать 
материальные свойства в Physics>Subdomain settings. Сбросить все 
изменения системы уравнений можно кнопкой Reset Equation. 

Для изменения формул ГУ служит окно Physics>Equation 
system>Boundary settings или Ctrl+F7. Работа с ним аналогична 
предыдущему. С помощью команды Physics>ODE settings в COMSOL 3.2 
можно добавить любые Обыкновенные Дифференциальные Уравнения.  
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1.6. Построение сетки 
 

После задания всех свойств и граничных условий наступает очередь 
построения сетки. Для простейших моделей, на первом этапе оценочного 
расчета можно задать сетку по умолчанию Mesh>Initialize Mesh (или 
кнопка с изображением треугольника) и несколько раз нажать 
Mesh>Refine mesh и получив достаточно мелкую сетку приступить к 
решению. При нажатии этих кнопок рабочая область переходит в режим 
Mesh Mode, и в рабочей области отображается разбиение фигуры. В 

ручную этот режим можно вызвать соответствующей кнопкой  или 
командой меню Mesh>Mesh Mode. Для моделей чистой кондукции, не 
связанных с потоком массы ,можно этим и ограничиться: для более мелких 
элементов сетки система автоматически произведет сгущение, а если 
необходимо в какой-либо части системы еще более сгустить сетку, то 
можно нажать кнопку Refine selection и указать нужную область. В 
одномерном и двумерном стационарном режиме можно посоветовать 
просто делать наиболее мелкую сетку – скорость вычисления на 
современных компьютерах все равно будет приемлемой. В моделях 
учитывающих конвекцию надо всегда помнить, что размер конечного 
элемента должен быть в несколько раз меньше толщины пограничного 
слоя иначе решение может не сойтись и будет в любом случае 
нестабильно. Поэтому рекомендуется строить сетку такой густоты, чтобы 
между любыми двумя границами было не меньше десяти конечных 
элементов. 

 
 

Рис 1.5. Окно Mesh parameters. 
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По умолчанию, COMSOL строит в двумерном режиме треугольную, а в 
трехмерном тетраэдрическую сетку. Для задания параметров сетки надо 
выбрать Mesh>Mesh parameters или нажать F9. Откроется окно настроек, 
на вкладке Global (Рис 1.5) можно выбрать один из предустановленных 
режимов. В списке Predefined mash sizes девять режимов от Extremely 
fine [Чрезвычайно точный] до Extremely coarse [Чрезвычайно грубый], 
остальные расположены между этими крайними режимами. В полях 
можно задать собственные значения параметров сетки. Maximum element 
size задает максимальный размер элемента. По умолчанию равен 1/15 
максимальной стороны, задавать его необязательно. Maximum element 
size scaling factor если ничего не задавать в предыдущее поле, то значение 
этого поля будет определять размер элемента (если задать 0.5, то размер 
элемента будет равнятся 1/30 максимальной стороны, если 0.1 то 1/150). 
Element growth rate [Темп роста элемента] отвечает за степень 
сгущения, принимает значения от единицы до бесконечности, чем ближе 
значение к единице тем более равномерная сетка. Mesh curvature factor и 
Mesh curvature cut off чем меньше эти значения, тем более точно задана 
криволинейность границы: при больших значениях этих параметров 
вместо кривой будет считаться ломанная линия. Resolution of narrow 
regions задает минимальное количество элементов по самой короткой 
границе, для точных вычислений рекомендуется устанавливать значения 
этого параметра не меньше десяти. 

Поле Mesh geometry to level  позволяет выбрать отдельно создание 
сетки для областей, поверхностей и ребер. Для большинства задач 
тепломассопереноса это значение должно быть областью Subdomain. 
Refinement method принимает два значения Regular и Longest и отвечает 
за режим работы команды Refine mesh. Если установлено значение 
Regular при нажатии этой команды каждый элемент делится на четыре 
части в 2D режиме, и на восемь в 3D. Значение Longest, делит каждый 
элемент на две части по самой длинной стороне. Вкладки Subdomain, 
Boundary, Edge и Point позволяют задать размер элемента для 
соответствующих элементов модели. Вкладка Advanced позволяет задать 
анизотропию сетки.  

Кнопка Remesh перестраивает сетку с новыми параметрами. 
В двумерном режиме для объектов близких к прямоугольным, можно 

задать четырехугольную сетку с помощью пункта меню Mesh>Map mesh 
или Ctrl+F9.  

В разделе Рабочая область и задание геометрии были упомянуты 
способы преобразования двумерных моделей в трехмерные с помощью 
команд Draw>Extrude и Draw>Revolve. Тогда после задания трехмерной 
геометрии придется заново строить сетку из тетраэдров, что может 
занимать значительное время. Иногда целесообразно сначала построить 
сетку в 2D режиме (треугольную или четырехугольную), а потом с 
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помощью команд Mesh>Extrude Mesh… растянуть фигуру с сеткой или 
Mesh>Revolve Mesh… раскрутить фигуру с сеткой. Тогда элементы будут 
не тетраэдрические, а в виде параллелепипедов или призм. Время 
построения такой сетки меньше, чем строить тетраэдрическую сетку 
заново, но на скорость расчета задачи вид сетки кардинально не влияет. 

 
 

1.7. Решающее устройство 
 

 Выбор решающего устройства и его параметров очень важен, так как 
в основном от него зависит достоверность вычислений. Неправильная 
настройка может привести к грубым ошибкам решения, которые очень 
трудно выявить. Также очень важно правильно оптимизировать решение, 
так как, к примеру, даже не очень сложная трехмерная модель элемента 
кассетной конструкции рассчитывается десятки минут на компьютере с 
процессором Athlon64 3000+ и 1Gb оперативной памяти, а некоторые 
нелинейные нестационарные модели могут рассчитываться многие часы 
даже на очень мощном компьютере.  

Кнопка Solve или пункт меню Solve>Solve problem запускает 
решающее устройство с текущими настройками. Кнопка Restart или пункт 
меню Solve>Restart перезапускает решающее устройство используя 
текущие значения (поле температур или скоростей) как начальные. Если 
мы рассматриваем стационарную задачу, то нажатие этой кнопки не 
должно менять решение. Колебания значений в этом случае говорят о 
нестабильности решения. Эту команду целесообразно применять для 
сложных расчетов, когда можно получить приближенный вариант решения 
на грубой сетке и для линейного или стационарного решателя, а потом 
сделав более мелкую сетку и при необходимости изменив решатель на 
нелинейный или переходный пересчитать задачу. Зачастую это позволяет 
получить решение быстрее, чем сразу запустив сложный расчет.   

Для изменения параметров нажмем F11 Solve>Solver parameters… 
или соответствующую кнопку. Откроется окно (Рис 1.6).    

Если стоит галочка Auto select solver, значит программа в зависимости 
от прикладного режима подобрала наиболее подходящее устройство, для 
несложных вычислений чаще всего менять его не надо.  

Выбирая решающее устройство, надо в первую очередь определиться 
стационарный или переходный процесс мы изучаем. Если процесс 
нестационарный, то в подавляющем большинстве случаев подходит 
решатель Time Dependent.  
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Рис.1.6. Окно Solver parameters. 
 

Для очень редких задач, связанных с нахождением собственных чисел 
дифференциальных уравнений, например волнового уравнения 
теплопроводности, надо выбирать решатель Eigenvalue. 

Если проблема стационарна, то надо определить линейна она или 
нелинейна. Если есть сомнения в линейности системы, то рекомендуется 
сразу устанавливать нелинейный решатель: если для линейной модели 
установить нелинейный решатель, то ответ будет корректен, но на 
вычисления затратится больше времени; а если для нелинейной задачи 
установить линейный решатель, то наверняка будут грубые ошибки. 

=>Внимание. Если в заданных коэффициентах присутствуют 
переменные (например, теплоемкость или теплопроводность) для 
которых мы задали зависимость от искомого поля (температуры) или 
от других связанных с искомым полем переменных, то задача 
нелинейная. Все задачи в которых учитывается теплообмен 
излучением, то есть где С или Ctrans (константа Стефана-Больцмана) 
не равна нулю – нелинейные. Модели, которые задают в прикладном 
режиме Incompressible Navier-Stokes практически всегда 
нелинейные.  

Для линейных и нелинейных стационарных задач можно выбрать 
параметрический решатель, в котором надо указать параметры, для 
которых задаётся несколько значений. Например, задать ряд разных 
теплопроводностей или мощностей для какого-либо объекта, а потом 
сравнить распределение температур при всех значениях параметра. После 
выбора решателя в поле Solver, задаем основные свойства. 
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Для Time Dependent на вкладке General это Time stepping [шаги по 
времени] в поле Times в формате 0:10:60 задаются временные слои. Здесь,  
от 0 до 60 секунд с промежутком 10 секунд. Единица измерения времени 
секунда, она устанавливается в Physics>Subdomain Settings в поле Time 
scaling coefficient. Если вместо 1 задать 1/60, то единица измерения 
времени будет равна 1 минуте. Поля tolerance определяют ошибку на 
каждом шаге итерации. Галочка Allow complex number позволяет 
применять в расчетах комплексные числа это нужно в случаях, если мы 
задали коэффициенты PDE в комплексном виде. Вкладка Time Stepping 
определяет шаги по времени. Пункт Times to store in output определяет 
какие временные шаги будут выводится для постобработки вычислений. 
По умолчанию стоит Specified Times, то есть времена определённые на 
вкладке General. Для того чтобы получить значения всех шагов 
решающего устройства надо выбрать Time steps from solver. Вообще, 
решающее устройство выбирает шаги произвольно, в зависимости от 
динамики системы, то есть игнорирует заданные значения Times на 
вкладке General. Чтобы решающее устройство учитывало этот список 
(например, если внешние воздействия импульсные и решатель может 
«проскочить мимо них») надо установить Time steps taken by solver в 
значение Strict(тогда решатель будет использовать только эти шаги) или 
Intermediate(решатель использует и свободные шаги и перечисленные на 
вкладке General) вместо стоящего по умолчанию Free. Если надо 
принудительно задать шаг по времени нужного размера, то это делается в 
поле Manual Tuning of step size. 

Для Eigenvalue необходимо задать количество собственных чисел 
уравнения в поле Desired number of eigenvalues и около каких значений  
искать собственные числа в поле Search for eigenvalues around. 

Для параметрических решателей надо установить имя параметра, 
который будет изменяться в поле Name of parameter и значения которые он 
будет принимать в поле List of parameter values. Значения можно 
перечислить через пробел, задать в виде 0:10:100 или задать как функцию 
linspace(1,100,25), то есть двадцать пять значений равномерно 
расположенных от 1 до 100. 

Для нелинейных решателей появляется вкладка Nonlinear где можно 
указать количество итераций, (по умолчанию стоит 25). Для сильно 
нелинейных проблем рекомендуется поставить галочку Highly nonlinear 
problem и увеличить количество итераций. 

Для всех режимов кроме Time Dependent можно установить галочку 
Adaptive Mesh Refinement, тогда в процессе решения сетка будет 
уточнена по сложному алгоритму. Если физика и геометрия достаточно 
сложна, и не очень ясно как задавать параметры сетки, рекомендуется 
установить эту галочку. Но это увеличит время вычисления. 
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Кроме того, можно установить Matrix symmetry в значение Symmetric 
если наша матрица симметрична. Чаще всего это бывает, если мы 
рассматриваем процессы чистой кондукции или диффузии. При выборе 
соответствующего линейного решателя это ускорит расчет. Матрицы 
заведомо несимметричны в мультифизических моделях, моделях 
связанных с конвекцией или уравнением Навье-Стокса.  

Большая часть времени расчета занята решением систем линейных 
уравнений, отвечает за их решение Linear system solver. По умолчанию 
стоит Direct(UMFPACK) этот решатель отнимает много ресурсов 
компьютера и для моделей требующих длительного расчета можно 
подобрать более подходящий. Если предыдущий решатель не работает или 
работает недопустимо долго, можно попробовать Direct (SPOOLES) он 
требует меньше памяти, но работает нестабильно. В крайнем случае 
выбирается итеративный решатель GMRES. Для положительно 
определенных систем с симметричными матрицами1 в выбирается Direct 
Cholesky (TAUCS) или итеративный Conjugate Gradients. Итеративные 
решатели потребляют меньше памяти, но надо следить за тем, что они 
сходятся и в случае необходимости увеличивать количество итераций. 

Уравнения чистой кондукции и чистой диффузии в стандартных 
режимах являются в стационарном состоянии эллиптическими, а в 
нестационарном параболическими. Для них очень эффективно 
использовать решатель Geometric multigrid. Часто в процессе решения 
какой-либо задачи, например теплового расчета при конструировании 
прибора, приходится перебирать большое количество материалов и 
изменять  геометрические параметры. Общие же принципы физической 
модели остаются теми же. В таком случае можно после длительного 
расчета стандартным решателем (UMFPAK) попробовать другие, и если 
они работают быстрее, а результат решения остается тем же, то 
дальнейшие исследования можно проводить уже с помощью более 
быстрого решателя – это сэкономит много времени. 

После задания свойств нажимаем кнопку Solve или команду 
Solve>Solve Problem. Часто после получения решения, модель и её 
параметры (физические свойства и граничные условия) немного 
изменяются. И если эти изменения не очень велики, то можно 
использовать команду Solve>Update model, тогда задача пересчитываться 
не будет, а новые значения будут получены методом интерполяции. Так же 
можно нажать кнопку Restart, тогда задача пересчитается, но за начальные 
Init значения будут заданы те, которые были получены на прошлом этапе. 
Это может немного ускорить вычисления. Так же с помощью этой 
                                                 
1 Способ определения положительно определенных систем с симметричными 
матрицами [symmetric, positive-definite systems] и методы настройки итеративных 
решателей подробно описаны в справке программы и литературе [2,4]. Но задачи 
чистой диффузии и кондукции обычно удовлетворяют этим условиям. 
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команды можно выявить нестабильность решения: если нажимая эту 
кнопку без изменения параметров модели мы получаем разные решения 
(осцилляции численного решения), то это говорит о нестабильности. В 
этом случае нужно уменьшить сетку или, если эта задача связана с 
конвекцией, применить Диффузионную стабилизацию в настройках 
физических свойств модели. 

 
 

1.8. Визуализация результатов 
 
   После завершения решения автоматически включается режим 
Postprocessing mode [Режим постобработки] в котором можно наблюдать 
результаты вычисления. Вручную этот режим можно включить 

соответствующей кнопкой  или командой Postprocessing> 
Postprocessing mode. По умолчанию, в расчетах теплопереноса выводится 
поле температур, в расчетах диффузии - поле концентраций, а в расчетах 
по уравнению Навье-Стокса - поле скоростей.  
 Рассмотрим одномерный, стационарный режим: после расчета чаще 
всего требуется получить распределение какого либо параметра по оси. 
Например, распределение температуры по длине стенки. По умолчанию, 
оно выводится прямо в рабочей области в виде графика. В случае 
нестационарного режима, выводится график распределения для 
последнего временного слоя. Настройки визуализации включаются 
командой Postprocessing>Plot parameters… или F12. Откроется окно Plot 
parameters с четырьмя вкладками (в режиме 1D).  

На вкладке General в поле Plot type надо выбрать какие параметры 
результатов вычисления будут отображаться, Line [Линия], Max/min 
marker [Метка максимума и минимума] и Geometry edges [Грани 
геометрии] – показывает или скрывает границы стенок. В поле Solution to 
use [Использование решения] в режиме переходного анализа можно 
выбрать временной слой (по умолчанию, изображается последний) в 
раскрывающемся списке Solution at time [решение для времени]. Если 
там выбрать пункт Interpolated, то в поле Time можно указать 
промежуточное значение времени и получить интерполированный расчет.  
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Рис.1.7. Распределение температуры в трехслойной стенке. 
 
В режиме параметрического решателя, в списке будут не временные слои, 
а значения параметра. 

На вкладке Line расположена галочка Line plot дублирующая 
аналогичную кнопку на вкладке General, поле Height data – данные по 
вертикальной оси – позволяет задать нужную нам переменную, которая 
будет отображаться по оси ординат. В режиме Heat transfer в списке 
Predefined quantities [Предопределенные значения] по умолчанию стоит 
температура, но есть возможность задать практически любой возможный 
параметр: Heat flux [Тепловой поток], Temperature gradient [Градиент 
температуры], а также все коэффициенты PDE (теплоемкость, 
теплопроводность и т.п. в случае теплопереноса) и все параметры 
граничных условий (например, внешнюю температуру или коэффициент 
теплоотдачи). При этом в поле Expression [Выражение] будет 
отображаться текущая переменная или задающее её выражение. К 
примеру, градиент температуры в программе задается так: gradT_ht. В это 
поле можно заносить и свои произвольные выражения, таким образом, 
вместо распределения абсолютных значений температуры по толщине 
исследуемой стенки - можно получить график перегревов. 

В поле Line color можно выбрать Uniform [Одноцветный] график или, 
для наглядности, Line color expression задать зависимость цвета линии от 
любого параметра.  

На вкладке Max/Min можно задать параметры этих маркеров. На 
вкладке Animation в режиме переходного (time dependent) или 

 26



параметрического (parametric) задаются параметры анимации результата 
вычислений. Анимацию можно сохранить в одном из нескольких видео 
форматов. 

В двумерном исследовании режим постобработки более обширен. На 
левой панели расположены кнопки предустановленных режимов. 2D 
Surface Plot – выводит значение скалярного поля (температуры, скорости 
или концентрации) в цветовом виде. 3D Surface Plot – выводит значение 
скалярного поля в виде трехмерной поверхности. Contour plot – выводит 
решение в виде изолиний (в режиме теплопереноса - изотермы). Arrow 
plot – выводит векторное поле (потока тепла, скоростей или потока 
диффузии) в виде стрелочек. Streamline plot – выводит векторное поле в 
виде линий потока. Line Plot – визуализация значений на границах в 
цветовом виде. Animate – в переходном режиме создает анимацию 
решения. Все эти кнопки дублируются в окне Postprocessing>Plot 
Parameters… F12, где можно задать всевозможные параметры вывода 
результатов. На вкладке General можно отметить галочками все виды 
визуализации которые будут выводиться, а на вкладках задать их свойства. 
На каждой вкладке можно выбирать любые переменные или задавать свои, 
определять цветовое соответствие результатам, задавать диапазон 
выводимых параметров и многое другое. 

Чтобы получить значение отображаемой величины в конкретной точке 
– можно щелкнуть мышкой в необходимом месте фигуры. Значение будет 
выведено в строке сообщений под рабочей областью вместе с 
координатами точки. При горящем переключателе SNAP можно 
посмотреть только значения в узлах решетки. Если нажать кнопку Draw 
Point for Cross-Section Point Plot. А потом поставить её на фигуру, то 
откроется окно с графиком изменения температуры во времени. Кнопка 
Draw Line for Cross-Section Line Plot позволяет провести через фигуру 
прямую линию и получить график температуры вдоль этой линии. Эти 
кнопки дублируют пункт меню Postprocessing>Cross-Section Plot 
Parameters… который открывает окно с тремя вкладками. На вкладке 
General можно выбрать временные слои или (при параметрическом 
решателе) значения параметров, для которых будет строится график. 
Вкладки Point позволяет задать координаты точек, для которых будет 
построен график и переменную, от которой он строится. Вкладка Line так 
же задает переменную и координаты линии, есть возможность задать 
количество равноотстоящих параллельных линий. В случае переходного 
анализа будет построен график для каждого выделенного временного слоя.  

Пункт меню Domain Plot parameters позволяет получить вид решения 
для каждой области отдельно или распределение переменной на границах 
и в углах фигуры. 

 В трехмерном режиме основным видом визуализации является Slice 
Plot [График сечений], в этом режиме показывается определенное 
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количество сечений расчетной области с распределением заданной 
переменной. Isosurface Plot показывает изоповерхности. Subdomain Plot 
показывает распределение скалярного поля переменной по всему объему. 
Boundary Plot – показывает распределение температур на всех границах 
фигуры. Остальные режимы аналогичны 2D. Все параметры 
соответствующих режимов визуализации настраиваются в окне 
Postprocessing>Plot Parameters… F12 

Кроме того в трехмерном режиме можно видеть кнопки отвечающие за 
«освещение» и ракурс объекта. 

Часто возникает необходимость проинтегрировать какой либо параметр 
по объему, поверхности или ребру. Команды Postprocessing>Subdomain/ 
Boundary/Edge Parameters… позволяют это сделать: можно выбрать 
необходимый элемент, задать переменную или выражение. Кстати, чтобы 
узнать площадь или объем (например, чтобы вычислить объемную 
мощность) объекта надо вместо подынтегрального выражения задать 1. 

Каждый из полученных графиков можно сохранить как в виде рисунка, 
так и в текстовый файл. Полностью экспортировать  все полученные 
данные можно с помощью пункта меню File>Export>Postprocessing Data. 

 
 

2. Раздел «Heat Transfer» («Теплоперенос») 
 

2.1. 1D. Стационарный режим 
 
Этот режим предназначен для расчета модели многослойных плоских 

стенок. Можно задать любые граничные условия, объемные источники и 
стоки тепла, и источники и стоки тепла на границе. Для цилиндрических 
стенок надо выбрать режим Axial symmetry (1D). 

Рассмотрим модель двухслойной стенки с граничными условиями I 
рода с одной стороны и III рода c другой. В первой стенке работает 
объемный источник тепла 10000 кВт/м3. 

 
НАВИГАТОР МОДЕЛЕЙ 

1. Откройте Model Navigator.  
2. Выберите в списке Space Dimension 1D.  
3. Application Mode выберите режим Heat 

Transfer>Conduction>Steady-state analysis. 
4. Нажмите OK.  
Откроется рабочая область с одной координатной осью.  

 
ЗАДАНИЕ ГЕОМЕТРИИ  

1. Выберите пункт меню Draw>Specify Objects>Line.  
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2. В открывшемся окне надо ввести координаты стенки в поле 
Coordinates.  
3. Пусть толщина стенок 5 см и 15 см. Введите в поле цифры 0 0.05  
4. Нажмите OK. В рабочей области на оси х появится линия, названная 
по умолчанию I1.  
5. Откройте окно Draw>Specify Objects>Line еще раз  
6. Введем цифры 0.05 0.2 для второй стенки.  

 Это же окно можно открыть, если щелкнуть на кнопке Line при 
нажатой клавише Shift  

7. Нажмите OK.  
8. Нажмите кнопку Zoom Extents для того чтобы расположить 
фигуру на весь экран.  

 
ФИЗИЧЕСКИЕ УСТАНОВКИ 
Свойства подобласти 

Теперь можно задавать физические свойства стенки.  
1. Откройте окно Physics>Subdomain Settings… (в последней версии 
программы оно вызывается клавишей F8).  
2. В Subdomain selection выберите номер стенки. В рабочей области эта  
область сразу выделится красным.   
3. Введем в поля свойства в соответствии с таблицей 1-1 

№ 
подобласти 

Толщин
а стенок 

Материа
л 

Теплопроводност
ь 

k [Вт/м*К] 

Объемная 
мощность 
Q [Вт/м3] 

1 5 см Медь 400 10 000 000 
2 15 см Асбест 0.11 0 
4. В стационарном режиме Density (плотность) и Heat capacity 
(теплоемкость) можно принять равными единице.  В остальных полях 
оставить нулевые значения. 

 
Граничные условия  

Переходим к заданию граничных условий.  
1. Откройте окно Physics>Boundary Settings… (F7).  
2. В Boundary selection выберите номер границы.  
В рабочей области соответствующая граница выделяется красным. 

Граница 2 – внутренняя, по умолчанию заблокирована. Чтобы её 
разблокировать, надо поставить галочку Interior boundaries.  

3. Введите граничные условия в соответствии с таблицей 1-2 
№ границы Граница Вид ГУ  Коэффициенты ГУ 
1 Среда-Медь Temperature T0=373 К 
2 Медь-Асбест Continuity  
3 Асбест-Среда Heat flux h=10 Вт/(м2*К)  Tinf=293 К 
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 Коэффициент теплоотдачи h можно использовать как суммарный 
коэффициент теплоотдачи (лучистый + конвективный), а можно только как 
конвективный – тогда необходимо определить поля для лучистого 
теплообмена: Const – произведение коэффициента черноты и постоянной 
Стефана-Больцмана 5,67*10-8 Вт/(м2*К4)  и Tamb – температура 
окружающих тел в кельвинах. Если используются эти поля, то везде в 
программе надо указывать абсолютные значения, а решатель выбирать 
нелинейный (так как коэффициенты ГУ будут зависеть от искомого поля 
температур). 

В нашем случае можно использовать линейный решатель, так как все 
физические свойства и коэффициенты приняты независящими от 
температуры.  
 
ГЕНЕРАЦИЯ СЕТКИ 

1. После задания всех граничных условий, определите сетку командой 
Mesh>Initialize Mesh или кнопкой . Получится пятнадцать узлов 
по длине стенки. Чтобы увеличить количество узлов надо нажать 

кнопку  [Mesh>Refine Mesh]. При необходимости её можно 
нажать несколько раз.  

 
РАСЧЕТ 

1. В меню Solve[Решать] выберите Solver Parameters[Параметры 
решателя]. 

2. В списке Solver[Решатель] выбираем Stationary 
linear[Стационарный линейный]. 

3. Нажимаем OK. 

4. Нажимаем кнопку Solve[Решать].  [Solve>Solve Problem]. 
Получаем распределение температуры по длине стенки в основном 
окне.  

 
2.2. 1D axial symmetry (Стационарный режим) 

 
Этот режим применяется для расчета бесконечных цилиндров и 

цилиндрических стенок. В качестве примера рассмотрим случай длинной 
трубки из стали, внутренняя стенка которой поддерживается при 
температуре 1000К. А наружная находится в вакууме, т.е. отдает энергию 
только в виде излучения. Температура окружающей среды принимается  
300K. 

Внутренний диаметр трубки R1, внешний R2. Коэффициент черноты 
0.98. 
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R1 0.05 м  
R2 0.15 м  
Tliq 1000 К Температура внутренней стенки 
Tamb 300 К Температура окружающих тел 
emissivity 0.98 Коэффициент черноты 
sigma 5.67 

Вт/м*К4
Константа Стефана-Больцмана 

 
НАВИГАТОР МОДЕЛЕЙ 

1. Откройте Model Navigator и выберите Axial symmetry (1D) в списке 
Space dimension. 

2. В списке прикладных режимов, откройте папку COMSOL 
Multiphysics>Heat Transfer выберите режим Conduction. 

3. Выберите Steady-state analysis. 
4. Нажмите OK. 

 
ЗАДАНИЕ ГЕОМЕТРИИ  

1. Теперь перейдите в меню Draw, выберите Specify Objects и нажмите 
Line. 

2. В окне Line, напечатайте  0.05 0.15 в поле r под надписью 
Coordinates. 

3. Нажмите OK. 
4. Нажмите кнопку Zoom Extents. 

 
КОНСТАНТЫ 

1. Откройте меню Options и выберите Constants. 
2. Введите две константы – коэффициент черноты поверхности и 

константу Стефана-Больцмана:  
NAME  EXPRESSION 
emissivity  0.98  
sigma  5.67e-8  

 
ФИЗИЧЕСКИЕ УСТАНОВКИ 
Свойства подобласти 

1. В меню Physics выберите Subdomain Settings. 
2. В окне Subdomain Settings выберите единственную подобласть 1 и 

введите следующие свойства стали:  
SUBDOMAIN  1  
k (isotropic)  55.563  
ρ  7850  
Cp  460  
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Установите начальное значение температуры, чтобы согласовать 
граничные условия. Его будет использовать, как начальное значение 
нелинейный решатель:  

1. Откройте в том же окне вкладку Init. 
2. Введите 1000 как начальное значение в поле Temperature. 
3. Нажмите OK. 

 
Граничные условия  

1. Откройте меню Physics и выберите Boundary Settings. 
2. В окне Boundary Settings выберите границу 1. 
3. В списке Boundary condition выберите Temperature. 
4. Напечатайте 1000 в поле Temperature. 
5. Выберите границу 2. 
6. В списке Boundary condition выберите Heat flux. 
7. Введите emissivity*sigma в поле Problem-dependent constant. 
8. Введите 300 в поле Ambient temperature [Окружающая 
температура]. 

9. Нажмите OK. 
Обратите внимание, что везде вводятся абсолютные значения 

температуры в кельвинах. Хотя во многих задачах и можно использовать 
относительные значения температур (В градусах Цельсия или перегревы), 
но если в условиях задается теплообмен излучением и используется 
константа Стефана-Больцмана, то обязательно надо вводить все значения 
температур в абсолютных значениях. Так же, в библиотеке материалов, 
свойства многих веществ зависят именно от абсолютных значений 
температуры. Поэтому рекомендуется даже в простейших задачах с самого 
начала использовать абсолютную шкалу температур. 
 
ГЕНЕРАЦИЯ СЕТКИ 

Создадим сетку конечных элементов кнопкой Initialize Mesh на 
главной панели инструментов (на кнопке изображен треугольник). По 
умолчанию будет сгенерировано 15 узлов.  
 
РАСЧЕТ 

1. В меню Solve[Решать] выберите Solver Parameters[Параметры 
решателя]. 

2. В списке Solver[Решатель] выбираем Stationary 
nonlinear[Стационарный нелинейный]. 

3. Нажимаем OK. 
4. Нажимаем кнопку Solve[Решать]. 
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ВИЗУАЛИЗАЦИЯ 
После работы решателя, в главном окне будет выведено распределение 
температур по толщине стенки (Рис 2.1).  
 

 
 

Рисунок 2.1. Распределение температур по толщине стенки. 
 

Чтобы получить численное значение в какой-нибудь точке стенки, 
можно щелкнуть мышью в этой точке и тогда значение температуры в 
ближайшем узле решетки будет выведено в строке сообщений. Чтобы 
узнать значение температуры на границе области выберите в меню 
Postprocessing пункт Point Evaluation, в открывшемся окне надо выбрать 
границу и нажать OK – тогда значение температуры будет выведено в 
строке сообщений. Граница 1 по условию поддерживается при 
температуре 1000 K. Температура на границе 2 по результатам вычисления 
при 15 узлах T=895.401929 К. Аналитический расчет дает значение 
T=895.401901 К.  

Чтобы приблизить численное значение к аналитическому, надо 
увеличивать количество узлов. В случае одномерного расчета, увеличение 
количества элементов не будет сильно влиять на длительность расчета. В 
данной задаче она составляет одну десятую секунды. 
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2.3. 1D axial symmetry (Нестационарный режим) 
 

Покажем пример расчета переходного процесса, в одномерном режиме. 
Для этого выполните следующее:  
 
НАВИГАТОР МОДЕЛЕЙ 

1. Откройте Model Navigator и выберите Axial symmetry (1D) в списке 
Space dimension. 

2. В списке прикладных режимов, откройте папку COMSOL 
Multiphysics>Heat Transfer выберите режим Conduction. 

3. Выберите Transient analysis. 
4. Нажмите OK. 

Повторите действия описанные в предыдущей модели в следующих 
пунктах вплоть до задания сетки включительно. Далее переходите к 
заданию решателя 
 
РАСЧЕТ 

1. В меню Solve[Решать] выберите Solver Parameters[Параметры 
решателя]. 

2. В списке Solver[Решатель] выбираем Time dependent [Зависимый 
от времени]. 

3. На вкладке General в первом поле Times вместо 0:0.1:1 вводим 
0:20:3000. Это значит, что для вывода решения будет использоваться 
шаг2 по времени 20 секунд. И расчет будет длится до 3000 секунд.  

4. Нажимаем OK. 
5. Нажимаем кнопку Solve[Решать]. 

 
ВИЗУАЛИЗАЦИЯ 

После работы решателя, в главном окне будет выведено 
распределение температур по толщине стенки для момента времени 3000 с. 
Распределение выглядит так же, как и при стационарном расчете – это 
связано с тем, что к этому моменту температурный режим уже 
установится. 

1. Откройте окно Postprocessing>Plot Parameters.  
2. Во вкладке General раскройте список Solution at time. Здесь можно 

выбрать значение времени для которого необходимо посмотреть 
распределение. 

3. Выберите значение 300. 
4. Нажмите кнопку Apply.  

                                                 
2 Этот шаг не имеет отношения к точности решения, но для визуализации он важен. Т.е. 
в самом решателе шаг по времени достаточно маленький – он колеблется в 
зависимости от скорости изменения температуры. 
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Вы увидите распределение температур в этот момент времени. По 
умолчанию оно выводится в виде черной линии.  

5. Выберите вкладку Line в области Line Color переключите 
радиокнопку из значения Uniform Color [Неизменный цвет] 
значение Use expression to color lines[Используйте выражение для 
расцветки линий]. Тогда распределение температур будет более 
наглядным. 

6. Теперь перейдите во вкладку Animate[Анимация]. Здесь можно 
выбрать формат и разрешение выходного файла и период времени, 
для которого создается анимация. 

7. Проверьте, что выбраны все шаги времени. Для того чтобы выделить 
все шаги – выделите один из них и нажмите Ctrl+A 

8. Нажмите кнопку Start Animation. Подождите около минуты, пока 
будет создаваться анимация. После этого вы можете просмотреть 
анимацию и сохранить AVI или MOV файл.  

9. Закройте окно с анимацией и нажмите OK. 
10. Теперь откройте окно Postprocessing>Cross-Section Plot Parameters.  
11. Во вкладке General проверьте, что выбраны все шаги времени. 
12. Затем выберите вкладку Point. 
13. В поле Coordinates r: выберите значение 0.15 – правая граница 

стенки 
14. Нажмите OK. 

Вы увидите окно с графиком переходного процесса для границы стенки: 
 

 
 

Рисунок 2.3. Изменение температуры на границе стенки со временем. 
 

 35



 С помощью кнопки Zoom window можно увеличить любую часть 
графика. Для того чтобы определить время выхода в стационар, закройте 
или сверните окно с графиком. 
 15. Во вкладке Point в поле Expression введите 895.402-T 
 16. Нажмите OK. 

17. Используя кнопку Zoom window найдите на отобразившемся 
графике момент времени, начиная с которого значение температуры на 
правой границе отличается от стационарного на 1 К.  

 

 
 

Рисунок 2.4. Изменение температуры на границе стенки со временем. 
 

18. По графику можно видеть, что выход на стационар с точностью 1 К 
происходит примерно через 1800 секунд (30 минут после начала 
процесса) 
Другой способ вывода результатов расчета переходного процесса, 

заключается в совмещении на одном рисунке графиков для различных 
моментов времени. 

19. Откройте окно Postprocessing>Domain Plot Parameters.  
20. В области Plot type включите радиокнопку Line/Extrusion Plot. 
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21. В области Solutions to use [Используемые решения] раскройте 
список Select via: и выберите пункт Interpolated times 
[Интерполированные значения времени].  

22. В поле Times введите через пробелы следующие значения времен: 
100 200 500 900 1300 2000 

23. Выберите вкладку Line/Extrusion в области Plot type выберите 
радиокнопку Line Plot.  

24. В поле Expression должно стоять T. В списке Subdomain Selection 
должен быть выбрана подобласть один. 

По умолчанию, после нажатия ОК, будут выведены разноцветные, 
сплошные линии, без «легенды» - это неудобно при печати.  

25. Поэтому нажмите кнопку Line settings.  
26. В открывшемся окне в списке Line color выберите Color. В списке 

Line style выберите Cycle. В списке Line marker выберите Cycle.  
27. Нажав кнопку Color можно выбрать любой цвет. 
28. Поставьте галочку Legend. 
29. Нажмите OK в окне Line settings. 
30. Нажмите OK в окне Domain Plot Parameters. 

Откроется график (Рис 2.5). 

 
 

Рисунок 2.5. Распределение температур в стенке для различных моментов 
времени. 

 37



2.4. 2D. Нестационарный режим 
 

Пример двумерного моделирования рассмотрим на примере 
процесса нестационарного теплообмена для пластины, 
теплоизолированной снизу и слева, и частично – сверху [3]. Начальная 
температура пластины T0=293 K, её ширина L=0,02 м, высота H=0.03 м. В 
направлении перпендикулярном к плоскости схемы, температура не 
меняется (плоская задача). Теплофизические свойства пластины:  

 
плотность ρ=2800 кг/м3

теплоемкость С=2000 Дж/(кг*К) 
теплопроводность k=1.7 Вт/(м2*К) 

 
Левая грань и правая половина верхней грани обмываются 

жидкостью, температура которой меняется соответственно по законам: 
)]exp(1[10)(10 tTTtT ⋅σ−−⋅∆+=  и )exp(*)sin(22)(20 ttTTtT ⋅η−⋅ω⋅∆+= ,  

где Т1=393К Т2=373 К, ∆Т1=Т1-Т0=100 К, ∆Т2=50К, σ=0,01 с-1, ω=0,05 с-1
, 

η=0,003 с-1, с коэффициентами теплоотдачи соответственно β1=60000 
Вт/(м2*К) и β2=40000 Вт/(м2*К). Необходимо найти нестационарное поле 
температур.  
 
НАВИГАТОР МОДЕЛЕЙ 

1. Откройте Model Navigator и выберите 2D в списке Space dimension. 
2. В списке прикладных режимов выберите папку COMSOL 

Multiphysics [FEMLAB]>Heat Transfer и элемент Conduction. 
3. Выберите Transient analysis. 
4. Нажмите OK. 
 

МОДЕЛИРОВАНИЕ ГЕОМЕТРИИ 
1. В меню Draw выберите Specify Objects и нажмите Rectangle. 
2. В окне Rectangle, найдите область Size и введите 0.03 в поле Width 

[Ширина], затем введите 0.02 в поле Height [Высота] 
3. Нажмите OK. 
4. В меню Draw выберите Specify Objects и нажмите Point. 
5. В поле х введите 0.015, в поле y введите 0.02. Для того чтобы 

верхняя граница была разделена на две части. 
6. Нажмите OK. 
7. Нажмите кнопку Zoom Extents. 
 

КОНСТАНТЫ И ВЫРАЖЕНИЯ 
1. Откройте меню Options и выберите Constants. 
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2. Введите следующие константы для задания выражений для 
граничных условий:  

NAME EXPRESSION  
T1 393 
T2 373 
deltaT1 100 
deltaT2 50 
sigma 0.01 
omega 0.05 
eta 0.003 
T0 293 

3. Нажмите OK. 
4. Откройте окно Options>Expressions> 

Boundary Expression [Выражения на 
границах]. 

5. Выберите левую границу 1, в поле Name 
введите Tliq, а в поле Expression закон по 
которому изменяется температура 
T0+deltaT1*(1-exp(-sigma*t)). 

 
6. Выберите верхнюю границу 4, и введите в поле Expression второй 

закон T2-deltaT2*sin(omega*t)*exp(-eta*t). Теперь в граничных 
условиях можно будет задать переменную Tliq, а нужный закон 
подставится автоматически в зависимости от номера границы. 

7. Нажмите OK. 
 

Рисунок 2.6. 
Закон изменения температуры 
жидкости омывающей верхнюю 
границу пластины. 

Закон изменения температуры 
жидкости омывающей левую 
границу пластины. 

 
ФИЗИЧЕСКИЕ УСТАНОВКИ 
Свойства подобласти 

1. В меню Physics выберите Subdomain Settings. 
SUBDOMAIN  1  
k (isotropic)  1.7 
ρ  2800 

2. В окне Subdomain Settings выберите 
единственную подобласть 1 и введите 
следующие свойства:  

 Cp  2000 
Теперь установите начальное значение температуры.  

4. Откройте в том же окне вкладку Init. 
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5. Введите T0 как начальное значение в поле Temperature.  
6. Нажмите OK. 

 
Граничные условия  

1. Откройте меню Physics и выберите Boundary Settings. 
2. В окне Boundary Settings выберите границу 1. 
3. В списке Boundary condition выберите Heat flux. 
4. Напечатайте 60000 в поле h - Heat transfer coefficient. 
5. Введите Tliq в поле Tinf - External Temperature 
6. Выберите границу 4. 
7. Напечатайте 40000 в поле h - Heat transfer coefficient. 
8. Введите Tliq в поле Tinf - External Temperature 
9. Нажмите OK. 

Обратите внимание: несмотря на то, что для двух границ введена одна 
переменная Tliq, её значение для каждой границы будет разным, так как 
она определена через окно Boundary Expressions. 
 
ГЕНЕРАЦИЯ СЕТКИ 

Создайте сетку конечных элементов кнопкой Initialize Mesh на 
главной панели инструментов (на кнопке изображен треугольник). По 
умолчанию будет сгенерировано 629 конечных элементов. 
 
РАСЧЕТ 

1. В меню Solve[Решать] выберите Solver Parameters. 
2. В списке Solver[Решатель] выберите Time dependent. 
3. На вкладке General в первом поле Times вместо 0:0.1:1 вводим 

0:10:3000. 
4. Нажимаем OK. 
5. Нажимаем кнопку Solve[Решать]. 

 
ВИЗУАЛИЗАЦИЯ 

После окончания расчета вы увидите распределение температуры в 
пластине в момент времени 3000 секунд. Чтобы увидеть анимацию с 
предопределенными параметрами, можно нажать кнопку Animation . 
Если вы хотите увидеть распределение температур в виде 
изотермических линий нажмите кнопку Contour plot . Чтобы увидеть 
изображение теплового потока в виде стрелочек нажмите кнопку Arrow 
plot , отображение в виде линий тока включается кнопкой Streamline 
plot . Если вы не знаете как выглядит какая-нибудь из 
упоминающихся кнопок, медленно проведите мышью над панелью 
инструментов, над кнопками появляются всплывающие подсказки. 
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2.5. 3D. Стационарный режим 
 

Ребристая трубка 
 

Эта модель симулирует тепловые процессы, происходящие при 
охлаждении горячих жидкостей с помощью стеклянных трубок с 
поперечным. Такие трубки применяются в химической промышленности. 
Модель интересна прежде всего способом задания коэффициентов 
теплоотдачи на поверхности. Она не затрагивает процессы происходящие 
в жидкости и воздухе, что упрощает расчет, но, тем не менее модель дает 
хорошие результаты.  

 
 

Рисунок 2.7. Вид модели. 
 

Для многих геометрических форм существуют полуэмпирические 
выражения для вычисления коэффициента конвективной теплоотдачи. В 
этой модели применяется зависимость для естественной конвекции, 
охлаждающей цилиндр, для вычисления коэффициента для внешней 
поверхности и значение для вынужденной конвекции на внутренней 
поверхности трубки. 

На входе в трубку внутренний диаметр составляет 16 мм. Толщина 
стенок 3мм, на оребренной части 4мм. Толщина ребер 4 мм, а высота 10  
мм. Предполагается, что охлаждение только естественно, то есть 
нагреваемый трубкой, воздух, расширяясь, создает восходящий поток.  

Расчет основан на уравнении стационарного теплообмена 
 

0)( =∇−⋅∇ Tk                  2.1 
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где k - теплопроводность материала [Вт*м-1К-1], а T температура [K]. И на 
граничных условиях третьего рода:  
 

)()( inf0 TThqTkn −+=∇−⋅−                     2.2 
 

где n - вектор нормали, h - коэффициент теплоотдачи [Вт м-2К-1], и Tinf - 
температура окружающей среды [K].  

На стороне жидкости можно взять приближенное значение 
коэффициента теплоотдачи h равное 15 Вт м-2К-1, потому что скорость 
жидкости близка к постоянной, а температура на протяжении трубки 
уменьшается незначительно.  

Выражение для h со стороны воздуха более сложное. Принимаем, 
что свободная конвекция на ребрах близка к конвекции вокруг цилиндра. 
Коэффициент теплообмена находим из критериального уравнения:  

 
4141 )()( Grf

L
khGrfNu ⋅θ==>⋅θ=                   2.3 

 
где k  - теплопроводность воздуха (=0,06 Вт м-1K-1), L - характеристический 
размер, который в данном случае равен внешнему диаметру ребер (44 мм), 
и f(θ) эмпирический коэффициент приведенный в следующей таблице 
 

УГОЛ  
[ГРАДУСЫ]  F(Θ)  УГОЛ 

 [ГРАДУСЫ] F(Θ)

0  0.48  130  0.38  
90  0.46  140  0.35  
100  0.45  150  0.28  
110  0.435  160  0.22  

 120  0.42  180  0.15  
 
Gr – критерий Грасгофа, определяемый уравнением [1] 
 

2

3

µ
∆β

=
TLgGr              2.4 

 
β - коэффициент теплового расширения (1/К), который равен 1/T для 
идеального газа, g - гравитационная постоянная (9.81 м/с2), а µ 
кинематическая вязкость (18x10-6 м2/с) 

=>В этой модели немного нарушена обычная последовательность 
деятельность – это связано с тем, что трехмерная модель создается 
преобразованием двумерной. 
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НАВИГАТОР МОДЕЛЕЙ 

Откройте Model Navigator на вкладке New . В списке Space 
dimension выберите 2D, затем нажмите OK.  
 
КОНСТАНТЫ И ВЫРАЖЕНИЯ 

1. В меню Options выберите Constants. Определите следующие 
константы, а потом нажмите OK:  
NAME  EXPRESSIONNAME EXPRESSION 
D  4.4e-2 Hh  15 
K  0.06 visc  18e-6 
Tinf  298 beta  1/Tinf 
Tinner  363 grav  9.81 

2. Из меню Options выберите Interpolation Functions 
[Интерполяционные зависимости]. 

3. В открывшемся окне нажмите кнопку New. В поле Function name 
введите graph, затем в списке Interpolation metod выберите Linear. 
Нажмите OK. 

4. В окне Interpolation Functions, введите следующие значения в 
столбцы x и f(x); после, нажмите OK:  
X  F(X)  X  F(X)  X  F(X)  X  F(X)  
0  0.48  110  0.435  140  0.35  180  0.15  
90  0.46  120  0.42  150  0.28    
100  0.45  130  0.38  160  0.22    

5. Из меню Options выберите Axes/Grid Settings. 
6. Очистите галочку Axis equal, затем введите следующие свойства:  

СВОЙСТВО ЗНАЧЕНИЕ  СВОЙСТВО ЗНАЧЕНИЕ 
x min  -1.4  y min  0.2  
x max  2.6  y max  2.8  

7. Перейдите во вкладку Grid, очистите галочку Auto, затем введите 
свойства, затем щелкните OK:  
СВОЙСТВО  ЗНАЧЕНИЕ 
x spacing  0.1  
y spacing  0.1  

 
 
СОЗДАНИЕ ГЕОМЕТРИИ  
Создайте двумерную геометрию: 
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Создайте прямоугольник R1 в следующей последовательности:  

1. Нажмите на клавиатуре клавишу Shift, и удерживая её нажмите 
кнопку Rectangle/Square панели инструментов. В открывшемся окне 
введите следующие значения, а затем нажмите OK: 

РАЗМЕРЫ ОБЪЕКТА ЗНАЧЕНИЕ РАЗМЕРЫ 
ОБЪЕКТА  

ЗНАЧЕНИЕ 

Width  0.8  x-position  0  
Height  0.4  y-position  0.8  
Base  Corner    

Создайте объект CO1 так:  
1. Нажмите кнопку 2nd Degree Bezier Curve на панели рисования. 
2. Щелкните мышью на координатах (0, 1.2), (0.2, 1.2), и (0.2, 1.4). 
3. нажмите кнопку Line, затем щелкните в точке (0.6, 1.4). 
4. Снова нажмите 2nd Degree Bezier Curve. 
5. Нарисуйте кривую Безье нажимая мышью в координатах (0.6, 1.4), 

(0.6, 1.2), и (0.8, 1.2). 
6. Щелните правой кнопкой мыши для завершения объекта. 

Напоминаем, что посмотреть координаты мыши можно в левом 
нижнем углу окна. 

Создайте объект CO2 следующим образом:  
1. Нажмите кнопку Line на панели рисования, нажмите на координатах 

(0.2, 1.4), (0.2, 2.0), (0.4, 1.9), (0.6, 2.0), and (0.6, 1.4). 
2. Щелкните правой кнопкой, чтобы завершить объект. 

Создайте объект CO4:  
1. Нажмите кнопку 2nd Degree Bezier Curve. 
2. Щелкните на координатах (0.2, 2.0), (0.2, 2.2), (0.4, 2.2), (0.6, 2.2), and 

(0.6, 2.0). 
3. Нажмите кнопку Line, затем щелкните на координатах (0.4, 1.9) и 

(0.2, 2.0). 
4. Нажмите правую кнопку мыши. Чтобы создать CO4, необходимо 

добавить квадрат и линии в объект. 
5. Нажмите кнопку Shift и щелкните на кнопку Rectangle/Square 

(Centered). 
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6. В окне введите данные в соответствии с таблицей, и нажмите OK:  
ПАРАМЕТРЫ ОБЪЕТА ВЫРАЖЕНИЕ 
Width  0.1  
α  45  
Base  Center  
x-position  0.4  
y-position  2.05  

7. Нажмите кнопку Line, щелкните на левом углу маленького квадрата, 
а затем на точке с координатами (0.2, 2.1), потом щелкните правой 
кнопкой мыши. 

8. Нажмите кнопку Line, щелкните на правом углу маленького 
квадрата, а затем на точке с координатами (0.6, 2.1), потом щелкните 
правой кнопкой мыши. 

9. Нажмите кнопку Line, щелкните на правом углу маленького 
квадрата, а затем на точке с координатами (0.4, 2.2), потом щелкните 
правой кнопкой мыши. 

10. Нажмите кнопку Line, щелкните на правом углу маленького 
квадрата, а затем на точке с координатами (0.4, 1.9), потом щелкните 
правой кнопкой мыши. 

11. Чтобы создать объект, выберите CO3, SQ1, B1, B2, B3, и B4, затем 

нажмите кнопку Coerce to Solid  на панели рисования. (Выделить 
несколько объектов можно, удерживая кнопку Shift последовательно 
щелкать мышью на перечисленных объектах) 

Создайте следующие два ребра:  
1. Выделите R1, CO1, CO2, и CO4, затем нажмите кнопку Array 

.(Выделить несколько объектов можно удерживая кнопку Shift 
последовательно щелкать мышью на перечисленных объектах) 

2. В открывшемся окне введите следующие значения; затем нажмите 
OK:  
ХАРАКТЕРИСТИКА ЗНАЧЕНИЕ 
displacement - x  0.8  
displacement - y  0  
array size - x  3  
array size - y  1  

Теперь создайте объект CO10:  
1. Нажмите кнопку Line. 
2. Нажмите на нижнем левом углу прямоугольника R1, затем щелкните 

на координатах (-1.2, 0.8), (-1.2, 1.1), и (-0.8, 1.1). 
3. Нажмите кнопку 3rd Degree Bezier Curve[Кривая Безье третьего 

порядка]. 
4. Нажмите на координатах (-0.4, 1.1), (-0.4, 1.2), и (0, 1.2). 
5. Нажмите правой кнопкой мыши для завершения объекта CO10. 
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 Так как на самом деле моделируемый предмет достаточно маленький 
– несколько сантиметров диаметром, а мы его создавали в 
координатах порядка нескольких метров, его необходимо 
пропорционально уменьшить, то есть - масштабировать:  

1. Выберите все объекты комбинацией клавиш Ctrl-A. 

2. Нажмите кнопку Scale . 
3. В открывшемся окне введите следующие значения, затем нажмите 

OK:  
ХАРАКТЕРИСТИКА ЗНАЧЕНИЕ 
Scale factor - x  1e-2  
Scale factor - y  1e-2  
Scale base point - x  0  
Scale base point - y  0  

4. Нажмите кнопку Zoom Extents. Теперь фигура уменьшена в сто раз. 
 
СОЗДАНИЕ СЕТКИ 

1. В меню Mesh выберите Map Mesh. С помощью этого окна можно 
сгенерировать четырехугольные элементы. 

2. Во вкладке Boundary, выберите помеченные на рисунке границы: 

 
Для того чтобы отметить несколько границ, щелкайте на них 
последовательно, удерживая клавишу Ctrl. 
3. Поставьте галочку Constrained edge element distribution (оставьте 

значение 1 в поле Number of edge elements).  
4. Выберите следующие границы: 
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5. Поставьте галочку Constrained edge element distribution, затем в 
поле Number of edge elements введите 2. 

6. Нажмите Remesh, затем нажмите OK. 
7. Из меню Mesh выберите Revolve Mesh [Раскрутить Сетку]. 
8. В открывшемся окне, в поле α2 введите угол на который 

раскручивается фигура 180. 
9. Включите радио кнопку Angle from x-axis, и в поле θ введите 0. 
10. Нажмите OK. 

 Дело в том, что расчет сетки стандартных тетраэдрических элементов в 
трехмерном режиме занимает очень много времени. Поэтому часто 
приходится идти на некоторые хитрости. В данном случае, сначала 
создается профиль фигуры. Вообще, после этого можно с помощью 
команды Draw>Revolve создать трехмерную фигуру и сгенерировать 
тетраэдрическую сетку, задать физические свойства и произвести 
расчет. Но в уже созданном трехмерном объекте одна только генерация 
займет очень много времени, не говоря уже о расчете. К тому же, из-за 
большого количества криволинейных границ могут возникать ошибки 
генерации, для устранения которых придется очень тонко настраивать 
генератор сетки. Поэтому, можно сначала создать сетку, а потом 
«раскрутить» фигуру в месте с конечными элементами. Это займет не 
много машинного времени. Мало того, в этой задаче в целях ускорения 
расчета изначально генерируются не треугольные, а четырехугольные 
элементы. 

 
ФИЗИЧЕСКИЕ УСТАНОВКИ 

1. В меню Multiphysics выберите Model Navigator. 
2. В меню Multiphysics в правой стороне окна выберите Geom2 (3D). 
3. Из списка прикладных режимов выберите Heat Transfer 

Module>General Heat Transfer>Steady-state analysis.Если у вас есть 
этот модуль, или выберите FEMLAB>Heat 
Transfer>Conduction>Steady-state analysis 

4. Нажмите Add, и нажмите OK. 
Свойства подобласти  
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1. Из меню Physics выберите Subdomain Settings. 
2. Выберите все подобласти. 
3. Выберите свойства из библиотеки материалов, которая есть в 

программе. Нажмите кнопку Load. В окне, в списке Materials 
выберите Library1>Silica Glass. Нажмите OK. Будут загружены 
следующие свойства: 

Свойства материала 
МАТЕРИАЛ K ρ CP
Кварцевое стекло 1.38  2203  703 

4. Во вкладке Init, в поле Temperature введите исходную температуру 
323. 

5. Нажмите OK. 
 
Граничные условия 

1. В меню Physics выберите Boundary Settings. 
2. Выберите все внешние границы фигуры нажав Ctrl+A. 
3. В списке Boundary condition выберите Heat Flux, затем введите 

следующие свойства:  
СВОЙСТВО  ЗНАЧЕНИЕ
h  Hc  
Tinf  Tinf  

4. Нажмите Apply. 
5. Выберите границы на «срезах объекта», т.е. на 4 границы на торцах 

объекта. И все границы, которые представляют собой двумерный 
профиль трубки, который мы раскручивали в фигуру всего их 
пятьдесят штук. Это трудоемкая операция, но её необходимо 
выполнить. Если вы выполнили все операции по созданию 
геометрии в указанной последовательности, то номера границ будут 
(перепроверьте эти цифры): 

1,2,5,8,12,15,21,22,24,27,33,34,37,40,43,46,48,52,61,62,72,75,81,82,84, 
87,93,94,97,100,103,106,108,112,121,122,132,135,141,142,144,147,153, 
154,157,160,163,166,168,172,181,182,191,192 
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6. В списке Boundary condition выберите Thermal insulation 

[Тепловая изоляция], и нажмите кнопку Apply. 
7. Выберите границы, которые составляют внутреннюю часть трубы, 

скорее всего их номера: 
4,6,16,18,76,78,136,138 

 
8. В списке Boundary conditions выберите Heat flux, затем введите 

следующие свойства:  
СВОЙСТВО  ЗНАЧЕНИЕ
h  Hh  
Tinf  Tinner  

9. Нажмите OK. 
10. Из меню Options выберите Expressions>Boundary Expressions. 
11. В открывшемся окне, выберите все границы, которые контактируют 

с воздухом. Один из способов это сделать – открыть окно 
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Physics>Boundary Settings поставить галочку Select by group. И 
выбрать одну из этих границ, например 3. Автоматически выберутся 
все границы с таким же граничным условием. Теперь вернитесь в 
окно Boundary Expressions. 

 
 

 
 
12. Введите следующие выражения для выбранных границ, и нажмите 

OK:  
 

EXPRESSION  VALUE  
Hc  K/D*graph(angle)*Gr^0.25  
angle  90+180*atan(y/z)/pi  
Gr  grav*beta*(T-Tinf)/visc^2*D^3 

 
 
РАСЧЕТ 

1. В меню Solve откройте окно Solver Parameters. 
2. В списке Solver необходимо выбрать Stationary nonlinear.Так как 

Граничные Условия зависят от искомой температуры. Коэффициент 
теплоотдачи зависит от критерия Грасгофа, а следовательно и 
температуры. 

3. В списке Linear system solver выберите GMRES. Этот итеративный 
решатель уменьшит время расчета в три раза.  

4. В списке Preconditioner выберите Algebraic multigrid. 
5. В списке Matrix symmetry выберите Symmetric. (В предыдущих 

версиях пакета, поставьте галочку Symmetric Matrices). Это еще 
больше ускорит расчет. Но эту галочку можно ставить если матрицы 
симметричны. На практике это встречается если модель затрагивает 
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только кондукцию. А конвекция и излучение присутствуют только 
неявно в виде коэффициента теплоотдачи. 

6. Нажмите OK. 
7. Нажмите кнопку Solve на главной панели. На компьютере Athlon 

3000 c 1 гигабайтом оперативной памяти расчет длится чуть больше 
минуты. (При настройках нелинейного решателя по умолчанию 
время расчета этой модели достигает пяти минут). 

 
ВИЗУАЛИЗАЦИЯ 

По умолчанию результат будет выведен в виде пяти поперечных срезов, 
но заданная геометрия модели позволяет получить наглядный результат 
если будет показано распределение температуры на поверхности:  

1. В меню Postprocessing выберите окно Plot Parameters (В последней 
версии пакета Comsol 3.2 вызывается клавишей F12). 

2. Откройте вкладку General. Очистите галочку Slice[Срез], Затем 
поставьте галочку Boundary. 

3. Перейдите во вкладку Boundary. В списке Predefined 
quantities[Предустановленные параметры] выберите 
Temperature. 

4. Нажмите Apply. 
 Вообще, на вкладке Slice можно указать количество и расположение 
срезов для наглядности. Вместо Т в поле Expression можно вводить 
практически любые переменные и выражения. Например, T-273.15 , 
тогда будет выведена температура в градусах Цельсия. Температура 
поверхности на ребрах примерно на двенадцать градусов ниже, чем 
температура на поверхности трубки без ребер. Температурный перепад 
между жидкостью, температура которой 363 К и внутренней 
поверхностью трубы приблизительно 40 К, а между внешней 
поверхностью и окружающим воздухом около 15 К. Эти значения 
показывают, что перенос тепла с ребер эффективен. Так же можно 
видеть, что поток от жидкости к трубке ограничен. Чтобы повысить 
эффективность охлаждения имеет смысл увеличить диаметр трубки. 

 Если на вкладке Boundary ввести в поле Expression Gr. То можно 
наглядно увидеть распределение значений критерия Грасгофа по 
поверхности трубки. Для того чтобы увидеть распределение 
коэффициента теплоотдачи на поверхности выполните следующие 
действия: 
1. Откройте окно Postprocessing>Plot Parameters, выберите вкладку 

Boundary, и в списке Predefined quantities выберите Heat transfer 
coefficient. Нажмите OK. Если вы создавали эту модель в 
предыдущих версиях FEMLAB, то введите в поле Expression h_ht 
здесь h означает коэффициент теплоотдачи, а ht прикладной режим 
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(он указан в скобках в названии окна основной программы и в меню 
Multiphysics) 

2. Для того, чтобы узнать суммарную мощность потока уходящего с 
поверхности трубки, откройте окно Boundary Integration в меню 
Postprocessing. Как вы можете видеть, коэффициент значительно 
изменяется в зависимости от угла наклона 

3. Для того, чтобы выбрать все внешние границы откройте также окно 
Boundary Settings поставьте галочку Select by group. 

4. Выберите границу 3 из списка. Теперь автоматически выбраны все 
внешние границы. 

5. Вернитесь в окно Boundary Integration, затем в списке Predefined 
quantities выберите Normal total heat flux.(В предыдущих версиях 
Normal heat flux) Нажмите OK. 

6. Интегрированное значение в Ваттах будет выведено в строке 
сообщений внизу окна. Напомним, что это мощность только 
половины трубки, чтобы получить полную мощность надо умножить 
это значение на два. 

Тепловая мощность такой трубки будет таким образом равна 
приблизительно 1.6 Вт. 

 
 

2.6. Conduction and Convection 
 

 Этот раздел прикладного режима Heat Transfer предназначен для 
нахождения поля температур жидкости и окружающих жидкость тел при 
известном поле скоростей. Он основан, так же как и раздел Heat 
Transfer>Conduction, на дифференциальном уравнении 
теплопроводности, но один из членов уравнения зависит от скорости 
жидкости. (1.3) Мы рассмотрим пример расчета теплового режима стержня 
с источником мощности охлаждаемого потоком жидкости вдоль стержня. 

Расчет будем проводить для двумерной осесимметричной модели в 
стационарном режиме. Принято допущение, что условия на внешней 
границы трубы адиабатические, так как основная часть теплового потока 
уносится водой. Используется параметрический решатель, в котором 
варьируется скорость жидкости от 0 до 2 м/с. Стержень (диаметр 2 см., 
длина 20 см) принят стальным, охлаждающая жидкость – вода, поступает 
при комнатной температуре, профиль скорости параболический. 
Мощность источника в стержне равна 2 кВт. Объем стержня вычисляется 
из геометрических параметров с помощью интегральных переменных 
связи. Толщина прослойки воды – 2 см. Принято допущение, что  
теплофизические свойства воды не зависят от температуры и на скорость 
потока влияния не оказывают.  
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Теплофизические свойства стержня:  
 

плотность ρ=7805 кг/м3

теплоемкость С=475 Дж/(кг*К) 
теплопроводность k=44,5 Вт/(м2*К) 

 
Необходимо найти среднюю температуру жидкости на выходе в 

зависимости от скорости.  
 Несмотря на то, что мы рассматриваем стационарный режим, для 
жидкости необходимо указывать теплоемкость и плотность, так как от 
них зависит количество энергии которая переносится потоком 
жидкости. 

 
НАВИГАТОР МОДЕЛЕЙ 

1. Откройте Model Navigator и выберите Axial symmetry (2D)  в 
списке Space dimension. 

2. В списке прикладных режимов выберите папку COMSOL 
Multiphysics [FEMLAB]>Heat Transfer и элемент Convection and 
Conduction. 

3. Выберите Steady-State analysis. 
4. Нажмите OK. 
 

МОДЕЛИРОВАНИЕ ГЕОМЕТРИИ 
1. В меню Draw выберите Specify Objects и нажмите. 
2. В окне Rectangle, найдите область Size и введите 0.01 (Так как 

режим осесимметричный – надо вводить радиус) в поле Width 
[Ширина], затем введите 0.2 в поле Height [Высота] 

3. Нажмите OK. 
4. В меню Draw выберите Specify Objects и нажмите Rectangle. 
5. В окне Rectangle, в область Size введите 0.02 в поле Width [Ширина], 

затем введите 0.2 в поле Height [Высота], в область Position в поле r 
введите 0.01. 

6. Нажмите OK. 
7. Нажмите кнопку Zoom Extents. 

 
КОНСТАНТЫ И ВЫРАЖЕНИЯ 

1. Откройте меню Options и выберите Expressions>Global Expressions. 
2. Введите выражение в поле Name S, а в поле Expression -(0.01-(r))*50, 

теперь S это нормированная координата по толщине водной 
прослойки. 

3.  Нажмите OK. 
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4. Откройте меню Options и выберите Integration Coupling 
Variables>Boundary Variables… [Интегральные переменные 
связи>Переменные на границах] 

5. Выберите в списке Source границу 6 (через которую вытекает 
теплоноситель)  

6. Введите в поле Name Tint, a в поле Expressions T*2*pi*r/(0.0008*pi) и 
нажмите OK. 

 Так как у нас осесимметричная модель, чтобы получить интеграл по 
площади, надо домножить подинтегральную температуру на 2*pi*r. А 
затем разделить на площадь канала, она, в нашем случае вычисляется 
по формуле S=pi*(R^2-r^2)=pi*(0.03^2-0.01^2)=0.0008*pi  м^2. В 
режиме 2D достаточно было бы разделить T на длину границы.  

 Пункты 4-6 предназначены для визуализации графика средней 
температуры на выходе от скорости теплоносителя. Вообще 
переменные связи являются очень мощным инструментом задания 
параметров модели и визуализации. Они позволяют, к примеру, связать 
мощность источника с интегральной температурой тела. В данной 
задаче с помощью переменной связи, находится интегральная 
температура жидкости на выходе из модели. Это необходимо, так как с 
помощью окна Postprocessing>Boundary Integration можно только 
получить значение интеграла на конкретном временном слое или при 
одном значении параметра, но нельзя построить график. 
7. Откройте окно Options>Integration Coupling Variables>Subdomain 

Variables… [Интегральные переменные связи>Переменные в 
подобластях] 

8. Выберите подобласть 1, затем в поле Name введите Vsterj, а в поле 
Expression 2*pi*r, для того чтобы вычислить объем стержня.  

 Как и в случае интегрирования по границе, в осесимметричном 
режиме приходится домножать подынтегральное выражение на 2*pi*r. 
При расчете объема в декартовых координатах, для вычисления объема 
необходимо оставить под интегралом только 1. 
9. Нажмите OK. 

 
ФИЗИЧЕСКИЕ УСТАНОВКИ 
Свойства подобласти 
1. В меню Physics выберите Subdomain Settings.  
2. В окне Subdomain Settings введите следующие свойства для 

подобластей 1 и 2:  
SUBDOMAIN  1  2 
k (isotropic)  44.5 0.61 
ρ 7850 995.6 
Сp 475 4178 
Q 2000/Vsterj 0 
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u 0 0 
v 0 6*Vmean*S*(1-S) 

Теперь установите начальное значение температуры.  
3. Откройте в том же окне вкладку Init. 
4. Введите 300 как начальное значение в поле Temperature для обеих 

подобластей.  
5. Нажмите OK. 

 
Граничные условия  

1. Откройте меню Physics и выберите Boundary Settings. 
2. В окне Boundary Settings выберите левую границу 1. 
3. В списке Boundary condition выберите Axial symmetry. 
4. Выберите границу 5. 
5. Выберите ГУ Temperature и введите в соответствующем поле 300. 
6. На границе 6 установите Convective flux. 
7. На остальных границах оставьте адиабатическое условие Thermal 

insulation.   
8. Нажмите OK. 

Таким образом, температура втекающей воды установлена равной 300 К. 
 
ГЕНЕРАЦИЯ СЕТКИ 

Откройте окно Mesh>Mesh parameters… В списке Predefined mesh 
sizes на вкладке Global, выберите режим Finer и нажмите кнопку Remesh. 
Затем нажмите OK. Будет сгенерировано 416 конечных элементов. 

 
РАСЧЕТ 

1. В меню Solve[Решать] выберите Solver Parameters. 
2. В списке Solver[Решатель] выберите Parametric linear. 
3. На вкладке General в первом поле Name of parameter введите Vmean, 

а в поле List of parameter values [Список значений параметра] 
0:0.1:2. 

4. Нажимаем OK. 
5. Нажимаем кнопку Solve[Решать]. 

 
ВИЗУАЛИЗАЦИЯ 

После окончания расчета вы увидите распределение температуры при 
скорости 2 м/с. С помощью кнопки Animation , можно получить 
анимацию, в которой будет плавно изменятся скорость теплоносителя.  
Если открыть окно Postprocessing>Plot parameters… (F12) вы можете 
изменяя на вкладке General значение параметра в списке Parameter value, 
получать визуализацию для любого рассчитанного значения.  

1. Откройте окно Postprocessing>Cross-Section Plot Parameters.  
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2. Во вкладке General проверьте, что выбраны все шаги времени. 
3. Затем выберите вкладку Point. 

 Если вы сейчас введете координаты какой-нибудь точки и нажмете OK, 
будет выведен график зависимости температуры в этой точке от 
скорости потока. В связи с некоторыми особенностями данного 
применения конечноэлементного метода, значения температуры в 
различных точках теплоносителя будут сильно колебаться, а в 
некоторых точках опускаться ниже начальной температуры в 300 К. 
Чтобы избежать этого необходимо пользоваться инструментом 
Artificial Diffusion [Искусственная диффузия] на вкладке Subdomain 
Settings. В данной задаче не ставится цель найти распределение 
температур в жидкости, поэтому мы будем получать только 
интегральные температуры. 
4. В поле Expression введите имя переменной связи Tint. 
5. Нажмите OK. 

 
Будет выведен график: 
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3. Раздел Convection and Diffusion 
 

 Прикладной режим, связанный с конвекцией и диффузией 
описывается уравнениями аналогичными уравнениям 1.2 и 1.3 для 
прикладного режима теплопереноса. 
Для чистой диффузии, в общем случае нестационарное уравнение 

RcD
t
c

ts =∇−⋅∇+
∂
∂

δ )(  ,                    3.1 

где D коэффициент диффузии м2/с, R константа скорости реакции, с 
искомое поле концентраций,  временной коэффициент. tsδ
Граничное условие третьего рода 
 

)()( 0 cckNcDn bc −+=∇−⋅−                     3.2 
 
N0 - произвольное выражение потока, kc - коэффициент массопереноса, cb - 
объемная концентрация. 
Для прикладного режима конвекции и диффузии уравнение 3.1 
видоизменяется: 
 

RcucD
t
c

ts =+∇−⋅∇+
∂
∂

δ )(                     3.2 

 
добавляется поле скоростей, граничное условие: 
 

0)( NcucDn =+∇−⋅−                      3.3 
 
Рассмотрим одномерную задачу [3]: 
 Труба длиной L = 2м, разделенная на две равные части задвижкой, 
соединяет два резервуара, заполненные раствором NaOH. В резервуаре 
слева от задвижки находится раствор с концентрацией С1, а справа – 
раствор с концентрацией С0. После открывания задвижки жидкость 
начинает перетекать со скоростью с слева направо. Рассчитать 
нестационарное поле концентраций по длине трубы, считая задачу 
одномерной, на временном интервале [0; 0.2 L/c0]. Режим течения 
ламинарный. Коэффициент диффузии NaOH в воде принять D=10-9 м2/с. 
С1=0,01 кг/м3, С0= 0 кг/м3, скорость постоянна и равна с0 =1 мм/с. 
 Так как в программе концентрации указываются в молях на 
кубический метр, надо перевести кг/м3 в моль/м3. Молярная масса NaOH 
M=30 г/моль. Следовательно С1 = 1/3 моль/м3, 0,2L/c0 в данном случае 
равно 400 с. 
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3.1.  1D (Нестационарный режим) 
 

НАВИГАТОР МОДЕЛЕЙ 
1. Откройте Model Navigator и выберите 1D в списке Space dimension. 
2. В списке прикладных режимов, откройте папку COMSOL 

Multiphysics>Convection and Diffusion выберите режим Convection 
and Diffusion. 

3. Выберите Transient analysis. 
4. Нажмите OK. 

 
ЗАДАНИЕ ГЕОМЕТРИИ  

1. Выберите пункт меню Draw>Specify Objects>Line.  
2. В открывшемся окне надо ввести координаты трубы в поле 
Coordinates.  
3. Введите в поле цифры 0 1  
4. Нажмите OK.  
5. Откройте окно Draw>Specify Objects>Line еще раз  
6. Введем цифры 1 2 для второй части трубы.  
7. Нажмите OK.  
8. Нажмите кнопку Zoom Extents для того чтобы расположить 

фигуру на весь экран.  
 
ФИЗИЧЕСКИЕ УСТАНОВКИ 
Свойства подобласти 

1. В окне Physics>Subdomain Settings… выберите обе подобласти.  
2. В поле D введите 1e-9, в поле u – 1e-3 
3. Нажмите кнопку Artificial diffusion, поставьте галочку Isotropic 

diffusion, в поле tuning parameter введите 0.1 
4. Нажмите OK 
5. Перейдите на вкладку Init. Для подобласти 1 установите 1/3, для 

подобласти 2 оставьте 0 
6. Нажмите OK. 

 
Граничные условия  

1. Откройте окно Physics>Boundary Settings… (F7).  
2. Установите соответствующие ГУ 
№ границы Вид ГУ  Коэффициенты ГУ 
1 Concentration c0=1/3 моль/м3

2   
3 Concentration c0=0 моль/м3

3. Нажмите OK 
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ГЕНЕРАЦИЯ СЕТКИ 
1. Откройте окно Mesh>Mesh parameters.  
2. На вкладке Global в поле Maximum element size введите 0.05 
3. На вкладке Boundary выберите границу 2 
4. В поле Maximum element size введите 0.005 для того чтобы сгустить 

сетку на стыке подобластей, где в момент открытия задвижки 
существует разрыв поля концентраций.  

 
РАСЧЕТ 

1. В меню Solve[Решать] выберите Solver Parameters[Параметры 
решателя]. 

2. В списке Solver[Решатель] выбираем Time dependent [Зависимый 
от времени]. 

3. На вкладке General в первом поле Times вместо 0:0.1:1 вводим 
0:10:400.  

4. Нажимаем OK. 
5. Нажимаем кнопку Solve[Решать]. 

 
ВИЗУАЛИЗАЦИЯ 

После работы решателя, в главном окне будет выведено 
распределение концентраций для последнего момента времени. Можно 
увидеть сильно сглаженный скачок концентраций. Это обусловлено в 
основном влиянием не физической диффузии, которая достаточно мала, а 
влиянием диссипации численного решения [3], уменьшение шага по 
времени приводит к уменьшению диссипации, поэтому в задачах с 
движущимся скачком концентраций рекомендуется напротив, уменьшать 
шаг по времени и сетку. 

Откройте окно Postprocessing>Plot Parameters.  
1. Во вкладке General раскройте список Solution at time. Здесь можно 

выбрать значение времени для которого необходимо посмотреть 
распределение концентраций. 

2. Выберите значение 0. 
3. Нажмите кнопку Apply.  
Вы увидите распределение концентраций в начальный момент 

времени – ступенька. Небольшие скачки концентрации непосредственно 
рядом с перепадом – это влияние дисперсии численного решения, функция 
Artificial diffusion, как раз сглаживает эти колебания.  

 
4. Во вкладке Animate[Анимация] можно сгенерировать файл 

анимации. 
5. Теперь откройте окно Postprocessing>Cross-Section Plot Parameters.  
6. Во вкладке General проверьте, что выбраны все шаги времени. 
7. Затем выберите вкладку Point. 
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8. В поле Coordinates r: выберите значение 1.1 
9. Нажмите OK. 
10. Будет выведен график концентраций для точки 1.1 м в зависимости 

от времени. 
 

4. Основы мультифизического моделирования 
 
 Мы рассмотрели работу в прикладных режимах теплоперенос и 
диффузия. На практике приходится сталкиваться с более сложными 
задачами, в которых приходится искать не просто решение одной системы 
дифференциальных уравнений в частных производных, в виде поля 
скоростей, концентраций и температур, где начальные и граничные 
условия определены. А задачи где физические свойства, начальные и 
граничные условия зависят от решения другой системы, так же связанной с 
первым решением. К примеру задача, где поле температур зависит от поля 
скоростей теплоносителя, а поле скоростей определяется из температуры 
теплоносителя. Для таких задач в программе COMSOL Multyphysics 
предусмотрен режим мультифизического моделирования. В этой главе 
приведены последовательности действий для создания таких моделей в 
двумерном и трехмерном вариантах. Далее будут рассмотрены модели где 
связаны уравнения теплового баланса и Навье-Стокса.  
 

4.1. Конвективное охлаждение микросхем 
Модели, обсуждаемые в этом разделе, описывают воздушное 

охлаждение кассетных конструкций с источниками тепла в виде 
микросхем. Рассматривается два примера изображенных на рисунке 4.1: 
Вертикально расположенные платы, охлаждающиеся с помощью 
естественной конвекции и горизонтально расположенные платы с 
вынужденной конвекцией (охлаждение с помощью вентилятора). 

 
Рис. 4.1. Кассетная конструкция с внутренними источниками тепла.  

Линия A представляет центральную линию ряда микросхем, и область 
между линиями A-B на плате симметрична. 
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Легче всего задать конвективный поток с помощью коэффициента 
теплоотдачи, h. Тогда уравнения теплопереноса очень просто решаются. 
Но для этого требуется, чтобы коэффициент был точно определен. Многие 
задачи позволяют получить удовлетворительное решение без хорошего 
знания h, но в таком случае получение более точного решения очень 
трудно достичь.  

Вместо упрощения уравнений, существует альтернативный путь для 
более точного описания конвективной теплоотдачи – это модель 
учитывающая теплоперенос в комбинации с полем скоростей. Следующие 
учебные модели теплопереноса в монтажных платах используют два 
прикладных режима: General Heat Transfer и Non-Isothermal Flow. Первый 
пример моделирует естественное охлаждение в вертикально 
расположенной кассетной конструкции, изображенной на рис.4.1. 

 

 
 

Рис.4.2. Моделирование двумерной геометрии  (a), и трехмерной 
геометрии (b). 

 
В процессе моделирования удобно для начала рассчитать 

упрощенную двумерную модель для случая естественной конвекции. 
Рассчитываемый элементарный объем занимает место от дна платы до дна 
следующей платы, и проходит через центр ряда микросхем (как 
изображено линией A на рис.4.1). А уже потом создать трехмерную модель 
этого же элементарного объема. Рисунок 4.2 изображает два варианта 
геометрии для случая естественной конвекции.  
Геометрические параметры модели:  

• Плата: длина (в направлении потока) 0.13 м, толщина 0.002 м 

• Микросхемы: длина и ширина 0.02 м, толщина 0.002 м 

• Ширина воздушной прослойки между платами 0.010 м 
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Для случая вынужденной конвекции, трехмерная модель устанавливается 
поворотом геометрии изображенной на Рисунке 2 (b) так, чтобы платы 
оказались расположены горизонтально.  

 
Определение модели 

 
Модель использует два стационарных прикладных режима для 

моделирования проблемы: режим теплопереноса и режим 
неизотермического потока. 

Режим неизотермического потока (The Non-Isothermal Flow), 
моделируется с помощью уравнений Навье-Стокса, описывающих связь 
скорости жидкости, u, и давления, p, как:  

0)(
)(]))(3/2())(([)( 0

=ρ⋅∇
ρ−ρ+⋅∇−η−∇+∇η+Ι−⋅∇=∇⋅ρ

u
gIukuupuu T

             4.1 

Из-за нагрева жидкости, происходят отклонения локальной 
плотности, ρ, по сравнению с плотностью на входе, ρ0. В результате 
возникает местная выталкивающая сила выраженная как (ρ-ρ0)g. Модель 
так же рассматривает вязкость η, как зависящую от температуры. 

Режим теплопереноса основан на уравнении баланса энергии 
учитывающего скорость теплоносителя. 

 
TTuCQTk p ∇⋅ρ−=∇−⋅∇ )(           4.2 

 
где k - теплопроводность; Cp - удельная теплоемкость и Q - тепловая 
мощность в единице объема устанавливается равной 1,25 МВт/м3 (1 
Вт/микросхему) для трехмерного случая. Для двумерного необходима 
установить 2/3 от этого значения, чтобы учесть тот факт, что между 
микросхемами существует расстояние.  
 

Таблица. Свойства материалов 
  

Свойства материалов Источники тепла 
(кремний) 

Монтажная 
плата 
(FR4) 

ρ [кг/м3] 2330 1900 
Cp [Дж/(кг К)] 703 1369 
k [Вт/(м К)] 163 0.30 
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Модель рассматривает свойства воздуха как зависящие от 
температуры согласно следующим уравнениям:  

 
)/()( 0 RTMp w=ρ ,           4.3 

 
где p0 = 101.3 кПа, Mw = 0.0288 кг/моль, и R = 8.314 Дж/моль*К. Затем, 
Cp=1100 
 
log k = (-3,723+0,865 log(T))                    4.4 
 

T86 100.4100.6 −− ×+×=η            4.5   
           

Установите граничные условия для потока на входе как нормальный 
поток (normal flow) на границе с известным полем скоростей. Для моделей 
естественной конвекции, установите входную скорость на ноль. Для 
случаев вынужденной конвекции, установите параболический скоростной 
профиль (подобный полностью развитому профилю в ламинарном потоке), 
uy, где поток является функцией максимальной скорости umax, которая 
равна 1 м/с. Уравнение такого потока:  

 
uy=s(1-s)4umax           4.6 
 
где s - представляет нормированную ширину входа, предопределенный 
параметр в COMSOL Multiphysics который изменяется от 0 до 1 по 
каждому сегменту границы. Все выходы потока в моделях используют 
граничное условие normal flow/zero pressure. Кроме того, надо принять 
условие no-slip на всех поверхностях на плате и микросхемах. На входной 
температуре установите температуру 300 K (комнатная температура). На 
выходе потока используйте чисто конвективный теплообмен. Вы должны 
установить боковые периодические граничные условия в отношении 
температуры, которые установят равные температуры на обеих границах с 
одним значением координаты y. В конце концов, на всех внутренних 
границах принимается неразрывность теплового потока и температуры.  
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Естественная конвекция 

 
Рис.4.3. Распределение температуры в двумерной модели. 

 
Результаты решения двумерной модели (Рисунок 4.3) показывают, 

что температура верхних микросхем больше, чем температура нижних. Так 
перегрев самой нижней составляет всего 30 K, а верхней более 90 K. Это 
связано с тем, что часть потока уходящего с источника тепла (мощность 
каждой микросхемы 1 Вт) попадает на верхние микросхемы. Так же можно 
видеть, что такая же ситуация и на противоположной стенке, которая 
представляет собой дно следующей платы. Это также вносит свой вклад в 
нагрев последних микросхем. 

Трехмерный расчет несколько более сложен из-за того что систему 
уравнений надо решать для значительно большего количества конечных 
элементов. Результаты (Рисунок 4.4) показывают, что температура на 
микросхемах выше приблизительно на три градуса по сравнению с 
двумерным расчетом. 

 
Рис. 4.4. Распределение температуры по результатам трехмерного 

моделирования. 

 64



 
Результат трехмерного расчета более точен, так как учитываются 

расстояния между микросхемами по горизонтали. На Рисунке 4.5 
изображено поле скоростей для обоих случаев. Максимальная скорость в 
трехмерном расчете так же выше, чем в двумерном. Так же более важно, 
что в трехмерной модели учитываются вертикальные каналы между 
микросхемами. 

 
Рис.4.5. Поле скоростей в двумерной модели (a) и трехмерной (b). 
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Вынужденная конвекция—горизонтальные платы 

В этой модели задается определенная скорость воздуха на входе, что 
представляет ситуацию, когда платы охлаждаются вентилятором. Как 
показано на Рисунке 4.6, перегрев на верхних микросхемах относительно 
окружающего воздуха гораздо меньше, чем в случае естественной 
конвекции и составляет от 50 до 60 K. 

 
Рис. 4.6. Распределение температур в случае вынужденной конвекции  

в горизонтально расположенных платах. 

По полю скоростей изображенному на рис. 4.7, видно, что исходный поток 
перестраивается и максимальная скорость возникает в канале между 
микросхемами. 

 
Рис. 4.7. Распределение скоростей в случае вынужденной конвекции. 
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4.2. Моделирование двумерной задачи естественной 
конвекции 

 
Путь в библиотеке моделей: 
Heat_Transfer_Module/Electronics_and_Power_Systems/circuit_board_na
t_2D  
 
НАВИГАТОР МОДЕЛЕЙ  

1. Запустите COMSOL Multiphysics, в Model Navigator откройте 
вкладку New. 

2. В списке Space dimension выберите 2D. 
3. Нажмите кнопку Multiphysics. В списке прикладных режимов 

выберите Heat Transfer Module>General Heat Transfer, нажмите 
Add. 

4. Потом выберите Heat Transfer Module>Non-Isothermal Flow, 
нажмите Add, нажмите OK. 
Если у вас старая версия Femlab, или нет модуля Heat Transfer. 

Выберите режим Femlab>Heat Transfer>Conduction and Convection> 
Steady-state analysis, нажмите Add. Затем выберите Fluid dynamics> 
Incompressible Navier-Stocks>Steady-state analysis, нажмите Add, 
нажмите OK. 

 
ОПЦИИ И УСТАНОВКИ 

1. В меню Options выберите Constants, и введите их в соответствии с 
таблицей, нажмите OK:  
NAME  EXPRESSION  
q_source 2/3*1/(2e-3*20e-3^2)  
T0  300  
rho0_air 1.013e5*28.8e-3/(8.314*T0) 

2. Из меню Options выберите Expressions>Scalar Expressions, и 
определите следующие выражения, нажмите OK:  
NAME  EXPRESSION  
k_air  10^(-3.723+0.865*log10(abs(T)))  
rho_air  1.013e5*28.8e-3/(8.314*T)  
Cp_air  1.1e3  
eta_air  6e-6+4e-8*T  

 
МОДЕЛИРОВАНИЕ ГЕОМЕТРИИ 

1. Создайте три прямоугольника, выбрав в меню Draw, пункт Specify 
Object>Rectangle, и введя информацию из таблицы, нажмите OK:  

 
OBJECT  WIDTH  HEIGHT BASE  X  Y  
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R1  0.002  0.13  Corner 0  0  
R2  0.01  0.13  Corner 0.002 0  
R3  0.002  0.02  Corner 0.002 0.01 

2. Нажмите кнопку Zoom Extents. 
3. В рабочей области выберите прямоугольник R3, затем нажмите 

кнопку Array на панели рисования. В открывшемся окне, в области 
Displacement в поле y введите 0.03; а в области Array size в поле y 
введите 4. Нажмите OK. 

 
ФИЗИЧЕСКИЕ УСТАНОВКИ 
Свойства подобластей 

1. В меню Multiphysics выберите прикладной режим Non-Isothermal 
Flow (или Incompressible Navier-Stocks). 

2. В меню Physics выберите Subdomain Settings. 
3. Выберите подобласти 1 и 3–6. Снимите галочку Active in this 

domain, чтобы отключить режим Non-Isothermal 
Flow(Incompressible Navier-Stocks) в этих подобластях. 

4. Выберите подобласть 2 и введите следующие выражения в 
соответствующих полях:  
PARAMETER  EXPRESSION  
ρ  rho_air  
η  eta_air  
Fy  9.81*(rho0_air-rho_air) 

5. Нажмите OK чтобы закрыть Subdomain Settings. 
6. В меню Multiphysics выберите прикладной режим General Heat 

Transfer (Convection and Conduction).  
7. В меню Physics снова откройте окно Subdomain Settings и выбрав 

все подобласти, во вкладке Init введите T0 в поле Temperature. 
8. Откройте вкладку Conduction (Physics) и введите следующие 

значения. 
SUBDOMAIN  1  2  
k (isotropic)  0.3  k_air  
ρ  1900 rho_air 
Cp  1369 Cp_air  

9. Пока подобласть 2 выбрана, откройте вкладку Convection, поставьте 
галочку Enable convective heat transfer. (Если Вы работаете в 
прикладном режиме Convection and Conduction менять вкладку не 
надо). В поле x-velocity введите u, а в поле y-velocity введите v. 

10. Вернитесь на вкладку Conduction и выберите 3-6. Нажмите на 
кнопку Load, выберите Silicon, и нажмите OK.  

11. В поле Q введите q_source. 
12. Нажмите OK чтобы закрыть окно Subdomain Settings. 
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Граничные условия 

1. В меню Physics откройте Boundary Settings. 
2. Установите следующие граничные условия и нажмите OK (В 

прикладном режиме СС пункта Radiation type нет):  
BOUNDARY  5  22  
Boundary condition  Temperature Convective flux 
T0  T0    
Radiation type  None    

3. В меню Multiphysics выберите Non-Isothermal Flow(Incompressible 
Navier-Stocks).  

4. В меню Physics снова откройте Boundary Settings.  
5. Выберите все границы и установите условие No slip. 
6. Выберите границы 5 и 22, установите условие Normal flow>Pressure 

с давлением (pressure) равным 0. 
7. Нажмите OK. 
8. В меню Physics>Periodic Conditions откройте окно Periodic 

Boundary Conditions. 
9. На вкладке Source [Источник] выберите границу 1, В поле 

Expression [Выражение] введите T, и нажмите Enter. 
10. Открыв вкладку Destination [Адресат], поставьте галочку у границы 

27, и в поле Expression введите T. 
11. Откройте вкладку Source Vertices найдите списокVertex selection, 

выберите границы 1 и 2, затем нажмите кнопку >>. 
12. Откройте вкладку Destination Vertices. Выберите и добавьте точки 

21 и 22. Нажмите OK. 
 

ГЕНЕРАЦИЯ СЕТКИ 
1. В меню Mesh откройте окно Mesh Parameters. На вкладке Global. 

Из списка Predefined mesh sizes выберите Normal. 
2. На вкладке Subdomain выберите подобласть 2, в поле Maximum 

element size введите размер максимального конечного элемента в 
этой области 1.5e-3. Нажмите OK. 

3. В меню Mesh выберите Initialize Mesh. 
 

РАСЧЕТ 
Нажмите кнопку Solve на главной панели для запуска расчета.  
 
ВИЗУАЛИЗАЦИЯ 

1. Для создания Рисунка 2-3 откройте окно Plot Parameters в меню 
Postprocessing. 
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2. На вкладке Surface выберите Temperature из списка Predefined 
quantities в области Surface data. Нажмите OK. 

3. Для Рисунка 2-5 (a) установите Surface data в режим Velocity field и 
нажмите OK. 

 
4.3. Моделирование трехмерной задачи естественной 

конвекции 
 

Путь в библиотеке моделей: 
Heat_Transfer_Module/Electronics_and_Power_Systems/circuit_board_na
t_3D  
Повторите шаги из инструкции к двумерной модели в разделах Навигатор 
Моделей и опции и установки с одним отличием: в списке Space dimension 
выберите 3D.  
 
МОДЕЛИРОВАНИЕ ГЕОМЕТРИИ 

1. Создайте три параллелепипеда используя параметры из таблицы. 
Чтобы сделать это, откройте меню Draw и выберите Block.  
OBJECT  LENGTH X  LENGTH Y LENGTH Z BASE X BASE Y  BASE Z 
BLK1  0.015  0.002  0.13  0  0  0  
BLK2  0.01  0.002  0.02  0  -0.002  0.01  
BLK3  0.015  0.01  0.13  0  -0.01  0  

2. Нажмите кнопку Zoom Extents из Главного меню. 
3. Выберите объект BLK2 и затем щелкните кнопку Array на панели 

рисования. В области Displacement, в поле z введите 0.03; а в 
области Array size в поле z введите 4. Нажмите OK. 

 
ФИЗИЧЕСКИЕ УСТАНОВКИ 
Свойства подобластей  

1. В меню Physics выберите Subdomain Settings. 
2. Выберите подобласти 2-6. Очистите галочку Active in this 

subdomain для отключения прикладного режима Non-Isothermal 
Flow в этих подобластях. 

3. Выберите подобласть 1 и введите следующие выражения в 
соответствующих полях:  

 
PARAMETER  EXPRESSION  
ρ  rho_air  
η  eta_air  
Fz  9.81*(rho0_air-rho_air) 

4. Нажмите кнопку Artificial Diffusion, выберите Streamline diffusion, 
и нажмите OK. 
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5. Нажмите OK чтобы закрыть окно Subdomain Settings. 
6. В меню Multiphysics выберите прикладной режим General Heat 

Transfer.  
7. В меню Physics откройте окно Subdomain Settings. Выберите все 

подобласти. Щелкните на вкладки Init, и введите в поле 
Temperature T0. 

8. Во вкладке Conduction введите следующие значения:  
SUBDOMAIN  1  6  
k (isotropic)  k_air  0.3  
ρ  rho_air 1900 
Cp  Cp_air  1369 

9. Выделив 1, нажмите вкладку Convection. Включите галочку Enable 
convective heat transfer, затем в поля x-, y- и z-velocity введите u, v, 
и w, соответственно. 

10. Нажмите кнопку Artificial Diffusion. Выберите Streamline diffusion 
и нажмите OK. 

11. На вкладке Conduction, и выберите подобласти 2-5. Нажмите кнопку 
Load, выберите Silicon, и нажмите OK.  

12. В поле Q введите q_source. 
13. Нажмите OK чтобы закрыть окно Subdomain Settings. 
 

Граничные условия 
1. Из меню Physics выберите Boundary Settings. 
2. Установите граничные условия следующим образом; затем нажмите 

OK.  
BOUNDARY  3  4  
Boundary condition  Temperature Convective flux 
T0  T0    
Radiation type  None    

3. В меню Multiphysics выберите Non-Isothermal Flow.  
4. В меню Physics выберите Boundary Settings.  
5. Выберите все границы Ctrl+A, затем установите граничное условие 

No slip. 
6. Выберите границы 3 и 4, затем примените граничное условие 

Normal flow/Pressure с pressure of 0. 
7. На границах 1 и 34, установите условие Slip/Symmetry. 
8. Нажмите OK. 
9. В меню Physics выберите Periodic Conditions>Periodic Boundary 

Conditions (Периодические Граничные Условия). 
10. На вкладке Source выберите границу 2. В поле Expression введите T, 

и нажмите Enter. 
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11. На вкладке Destination, поставьте галочку на границе 29. В поле 
Expression введите T. 

12. На вкладке Source Vertices выберите и добавьте (используя клавишу 
“>>”), в этом же порядке, вершины 1, 2, 39, и 40.  

13. На вкладке Destination Vertices выберите и добавьте вершины 21, 
22, 43, и 44, также в приведенном порядке. Нажмите OK. 

 
ГЕНЕРАЦИЯ СЕТКИ 

1. В меню Mesh откройте окно Mesh Parameters. На вкладке Global 
выберите в списке Predefined mesh sizes пункт Finer. 

2. На вкладке Boundary выберите границу 2. В поле Maximum element 
size (Максимальные размер элемента) введите 3e-3.  

3. На вкладке Advanced. В поле x-direction scale factor введите 0.5. 
Нажмите OK. 

4. В меню Mesh нажмите Initialize Mesh. 
 

РАСЧЕТ 
1. В меню Solve откройте окно Solver Parameters. 
2. В списке Solver выберите Stationary nonlinear, и в списке Linear 

system solver выберите решатель Direct (UMFPACK). 
3. Нажмите Solve для расчета. Эта задача довольно требовательная к 

ресурсам компьютера так как искомые поля температур и скоростей 
зависят друг от друга, а так же потому что сетка выбирается 
достаточно мелкой.  Это необходимо, чтобы учесть граничные 
эффекты: тепловой и гидродинамический пограничные слои. Для 
расчета необходимы примерно 500 MB свободной оперативной 
памяти и достаточно мощный процессор. COMSOL Multiphysics 
достигает решения примерно за 15 минут на процессоре с тактовой 
частотой 1.5-GHz. 

 
ВИЗУАЛИЗАЦИЯ 

1. Для создания Рисунка 4 в меню Postprocessing откройте окно Plot 
Parameters.  

2. Во вкладке General снимите все галочки, а затем поставьте галочку 
Boundary. 

3. Откройте вкладку Boundary. В области Surface data в списке 
Predefined quantities выберите Temperature. Нажмите Apply. 

4. Для создания Рисунка 5 (b), Вернитесь на вкладку General, 
активируйте Slice и затем отключите галочку Boundary.  

5. На вкладке Slice в области Slice data раскройте список Predefined 
quantities и выберите поле скоростей - Velocity field. 

6. В полях x, y, и z levels введите 1, 0, и 8, соответственно. Нажмите 
OK. 
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4.4. Моделирование трехмерной задачи с вынужденной 
конвекцией 

 
Путь в библиотеке моделей: Heat_Transfer_Module/ 
Electronics_and_Power_Systems/circuit_board_forced_3D  
 

До сих пор мы рассматривали моделирование элементарного объема 
кассетной конструкции для случая естественной конвекции. Когда 
необходимо провести расчеты для вынужденной конвекции приходится 
задавать скорость потока и скоростной профиль. Получим новую модель 
преобразованием уже существующей, описанной в предыдущем разделе. 

 
МОДЕЛИРОВАНИЕ ГЕОМЕТРИИ 

1. Перейдите в режим Draw mode нажав кнопку Draw на Главной 
панели Main toolbar.  

2. Выберите все объекты, затем откройте окно Draw>Modify>Rotate. 
3. В поле Rotation введите угол -90.  
4. В области Rotation axis direction vector, и в полях x, y, и z введите 1, 

0, и 0, соответственно. Нажмите OK. 
Эти команды развернули модель на 90 градусов, для того, чтобы 
учитывать только вынужденную конвекцию. 
 

ФИЗИЧЕСКИЕ УСТАНОВКИ 
Граничные условия 

1. В меню Multiphysics выберите General Heat Transfer. 
2. В меню Physics откройте окно Boundary Settings. 
3. Когда окно откроется, установите следующие граничные условия и 

нажмите OK:  
BOUNDARY  5  29  
Boundary condition  Convective flux Temperature 
T0    T0  
Radiation type    None  

4. В меню Multiphysics выберите прикладной режим Non-Isothermal 
Flow.  

5. В меню Physics выберите Boundary Settings. 
6. Выберите границу 29, и в списке Boundary condition выберите 

условие Inflow/Outflow velocity.  
7. В поле y-velocity введите формулу параболического профиля 

скоростей   -4*(1e4)*(z)*(0.01-(z))*(z>0). Нажмите OK. 
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ГЕНЕРАЦИЯ СЕТКИ 
1. В меню Mesh откройте окно Mesh Parameters. На вкладке Global 

установите в списке Predefined mesh sizes густоту сетки Finer. 
2. Установите параметр Resolution of narrow regions равным 1. 
3. На вкладке Boundary выберите границу 2. В поле Maximum element 

size введите 3e-3; Установите параметр Element growth rate 
равным 2. 

4. Откройте вкладку Advanced. В поле x-direction scale factor введите 
0.5. Нажмите OK. 

5. В меню Mesh нажмите Initialize Mesh. 
 

РАСЧЕТ 
1. В меню Solve откройте окно Solver Manager. 
2. На вкладке Initial Value в области Initial value нажмите 

радиокнопку Initial value expression. 
3. На вкладке Solve For выберите прикладной режим Non-Isothermal 

Flow. 
4. Нажмите кнопку Solve в текущем окне. Процесс расчета займет 

примерно 7 минут и потребует 500 MB свободной оперативной 
памяти. 

5. Когда COMSOL Multiphysics получит решение исходного поля 
скоростей, откройте вкладку Init, затем в поле Initial value выберите 
Current Solution. 

Таким образом сначала с помощью уравнения Навье-Стокса находится 
поле скоростей, а потом оно импортируется в прикладной режим 
теплопереноса и расчет идет только в нем. В отличие от модели 
свободной конвекции друг на друга эти режимы не влияют: 
6. Нажав вкладку Solve For выберите  оба прикладных режима.  
7. Нажмите кнопку Solve чтобы получить финальный результат. Это 

также займет около 7 минут. 
 
ВИЗУАЛИЗАЦИЯ 

1. Для создания Рисунка 6, для начала откройте окно Plot Parameters в 
меню Postprocessing.  

2. На вкладке General поставьте галочку Slice и снимите Boundary. 
3. На странице Slice в области Surface data в списке Predefined 

quantities выберите Temperature.  
4. В поля x, y, и z levels введите 1, 10, и 0, соответственно. Нажмите 

Apply. 
5. Для создания Рисунка 7, откройте вкладку Slice и в списке 

Predefined quantities выберите Velocity field. 
6. В поле x levels введите 0, и нажмите OK. 
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Практические задания 
 

Задание 1 
Создайте двухмерную осесимметричную модель трубы в 

теплоизоляции. Расчет нестационарный. Начальная температура 300 К. 
Температура внешней среды 300 К. Коэффициент теплоотдачи внутри 
трубы 40 Вт/м2К. Снаружи 5 Вт/м2К. Коэффициент черноты 0.5. 
Температура теплоносителя T, и параметры трубы заданы. A –  
внутренний радиус. B – толщина трубы. С – толщина теплоизоляции. 
Длину трубы принять 1 м, условия на торцах адиабатические. Свойства 
материалов импортировать из библиотеки материалов или из справочника 
[5]. 

Найти время выхода на стационар, вывести графики изменения 
температуры на границах труба-теплоизоляция и теплоизоляция-среда в 
зависимости от времени.  
 Повторить расчет в одномерном осесимметричном режиме, сравнить 
результаты. 
Вариант Материал 

трубы 
Материал 
изоляции 

A,мм B, мм C, мм T,К 

1 Сталь Пенопласт 10 3 5 350 
2 Медь Резина 15 3 4 350 
3 Алюминий Стекловата 15 3 10 350 
4 Серебро Пластмасса 25 2 5 400 
5 Медь Резина 20 2 4 400 
6 Алюминий Стекловата 10 2 5 400 
7 Серебро Пластмасса 5 0.5 1 400 
8 Сталь Пенопласт 50 3 10 400 
9 Медь Резина 40 5 5 450 
10 Алюминий Стекловата 25 2 10 450 
11 Сталь Пенопласт 25 1 5 450 
12 Медь Резина 80 3 6 450 
13 Алюминий Стекловата 25 2.5 15 450 
14 Медь Пенопласт 35 2.5 20 373 
15 Алюминий Резина 45 3 8 373 
16 Серебро Стекловата 8 0.4 2 373 
17 Сталь Стекловата 25 2 5 373 
18 Медь Резина 20 2 5 373 
19 Алюминий Стекловата 10 1 4 500 
20 Серебро Пластмасса 5 0.2 1 500 
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Задание 2 
 

Создайте двумерную нестационарную модель стержня с квадратным 
сечением со стороной А, в котором находится нагреватель мощностью В 
кВт, температура окружающей среды С. Данные из таблицы в задании 1. 
На всех границах задать конвективный теплообмен h=20 Вт/м2К. 
Коэффициент черноты взять из справочника[5]. 
 

Задание 3 
 

На основе модели на странице 34 (§2.3), «теплообмен пластины» 
провести расчет для следующих данных. Привести график изменения 
температуры центра пластины. Найти максимальную температуру в 
пластине. 
 
Вариант T1,К T2,К σ,1/c ω,1/c η, 1/c β1, 

Вт/(м2*К) 
β2, 
Вт/(м2*К) 

1 393 373 0.01 0.06 0.001 60000 40000 
2 393 373 0.02 0.05 0.002 70000 45000 
3 393 373 0.03 0.04 0.003 65000 35000 
4 393 373 0.04 0.03 0.004 55000 30000 
5 393 373 0.05 0.07 0.005 70000 40000 
6 373 393 0.01 0.08 0.001 45000 45000 
7 373 393 0.02 0.06 0.002 50000 35000 
8 373 393 0.03 0.05 0.003 60000 30000 
9 373 393 0.04 0.04 0.004 70000 40000 
10 373 393 0.05 0.03 0.005 65000 45000 
11 400 380 0.01 0.07 0.001 55000 35000 
12 400 380 0.02 0.08 0.002 70000 30000 
13 400 380 0.03 0.06 0.003 45000 40000 
14 400 380 0.04 0.05 0.004 50000 45000 
15 400 380 0.05 0.04 0.005 50000 35000 
16 450 400 0.04 0.03 0.001 60000 30000 
17 450 400 0.03 0.07 0.002 80000 40000 
18 450 400 0.02 0.08 0.003 60000 45000 
19 400 450 0.01 0.05 0.004 70000 35000 
20 400 450 0.025 0.04 0.005 65000 30000 
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